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11. Protected Terminals 

Monitored Hot Stand By (MHSB) 

This section describes configuring the protected terminal in MHSB mode. 

A protected terminal in MHSB mode comprises two radios interconnected using a MHSB switch. This MHSB 

switch comprises one RF switch and up to four tributary switches depending on the number of tributaries 

requiring switching: 

 

 

 

 
 

The MHSB switch protect terminals against any single failure in one radio. It also monitors the alarm 

output of each radio and switches between radios if major radio link alarms occur. The MHSB switch will 

not allow a switch to a faulty radio. 

The MHSB switch uses a CPU to monitor the alarm status received from both the connected radios' alarm 

ports. When a relevant major radio link alarm is detected on the active radio (that is, transmitter, 

receiver, power supply or modem), the CPU switches a bank of relays that switches all the interfaces and 

the transmit port from the main radio to a functioning stand-by radio. The stand-by radio now becomes 

the active radio. 

The MHSB switch has a hysteresis of 30 seconds to prevent switching on short alarm transients. 

The tributary switch and the RF switch are both a 19-inch rack-mount 1U high chassis. The MHSB switch 

option is available for all Aprisa XE frequency bands. 
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Tributary Switch Front Panel 

 

 

 
 

No. Description Explanation 

1 Power supply input Input for DC power or AC power 

2 Protective earth M5 terminal intended for connection to an external protective 
conductor for protection against electric shock in case of a fault 

3 Interface ports Port for connecting to customer interface equipment 

4 Radio A interfaces These connect to the interface ports on radio A 

5 Radio B interfaces These connect to the interface ports on radio B 

6 Console For factory use only 

7 Ethernet Port for connecting to customer Ethernet network. This port is 
also used to set up and manage the radios remotely over an IP 
network 

8 Radio A Ethernet Connects to an Ethernet port on radio A 

9 Radio B Ethernet Connects to an Ethernet port on radio B 

10 Alarms Alarm input/output connections for customer equipment 

11 Radio A alarms Connects to the alarm port on radio A 

12 Radio B alarms Connects to the alarm port on radio B 

13 RF SW Provides power and signalling to the RF switch 

14 Mode switch Three-position locking toggle switch to set the MHSB switch into 
automatic mode or radio A / radio B test mode 

15 LEDs Mode and status LEDs 

 
 



 

Protected Terminals  |  183 

 

Aprisa XE User Manual 

 

Tributary Protection Switch LEDs 
 

LED Colour Appearance Explanation 

A Green Solid The radio is active and is OK 

 Green Flashing The radio is in standby mode and is OK 

 Red Solid The radio is active and there is a fault 

 No colour (off) - The tributary switch is in 'slave' mode and the 
switching is controlled by the master tributary 
switch 

 Red Flashing The radio is in standby mode, and there is a fault 

B Green Solid The radio is active and is OK 

 Green Flashing The radio is in standby mode and is OK 

 Red Solid The radio is active and there is a fault 

 No colour (off) - The tributary switch is in 'slave' mode and the 
switching is controlled by the master tributary 
switch 

 Red Flashing The radio is in standby mode, and there is a fault 

~ Green Solid The tributary protection switch is in 'auto' mode 

 Green Flashing The tributary protection switch is in 'slave' mode 

 Red Solid The tributary protection switch is in 'manual' 
mode (A or B) 

On Blue Solid Indicates that there is power to the tributary 
protection switch 

 

RF Switch Front Panel 
 

 
 

No. Description Explanation 

1 Radio QMA QMA connectors for connecting the protected radios 

2 Protective earth M5 terminal intended for connection to an external protective 
conductor for protection against electric shock in case of a fault 

3 Antenna port N-type female connector for connection to the antenna feeder 
cable. This view shows an internally mounted duplexer. If an 
external duplexer is fitted, the antenna port will be on the 
external duplexer 

4 Slave tributary 
switch outputs 

Connects to secondary tributary switch for control of additional 
interfaces 

5 Tributary switch Connects the RF switch to the tributary switch (the master if 
more than one tributary switch is required) 

6 LEDs Status LEDs 
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RF Protection Switch LEDs  
 

LED Colour Appearance Explanation 

Tx A Green Solid RF is being received from radio A 

Tx B Green Solid RF is being received from radio B 

On Blue Solid Indicates that there is power to the RF protection switch 
 

Slave Tributary Switches 

Each tributary switch protects up to eight ports. Up to three slave tributary switches may be added to a 

MHSB terminal to protect up to 32 ports. Each slave tributary switch is interconnected by means of the 

slave tributary switch ports on the RF switch, as shown below. 

 

Note: A tributary switch that is operating as a slave (rather than a master) has a RJ-45 V.24 loopback 

connector plugged into the console port. If the connector is missing, contact Customer Support. 

Alternatively, you can make this connector. Follow the standard pinouts for a V.24 RJ-45 connection (see 

‘QV24 Interface connections’ on page 273). 

 

 
 



 

Protected Terminals  |  185 

 

Aprisa XE User Manual 

 

MHSB Cabling 

The two radios are interconnected as follows: 

 

CAUTION: Do not connect Transmit to Receive or Receive to Transmit as this may damage the radio or the 

MHSB switch. 

 

 
 

Cables supplied with MHSB 
 

The following cables are supplied with a MHSB terminal: 

 Ethernet interface: RJ-45 ports standard TIA-568A patch cables . 

 Alarm interface: RJ-45 ports standard TIA-568A patch cables. 

 RF ports: two QMA male patch cables are supplied. 

 

MHSB Power Supply 
 

See ‘DC Power Supply’ on page 37 and ‘AC Power Supply’ on page 40. 
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Configuring the Radios for Protected Mode 
 

The MHSB switch does not require any special software. However, the radios connected to the MHSB 

switch must be configured to work with the MHSB switch. This sets the alarm outputs and inputs to 

function in MHSB mode. 

You must configure the interfaces of both radios connected to the MHSB switch identically. To perform 

this, you can either connect directly to the radio or use the test mode of the MHSB switch. 

 

MHSB Terminal IP Addresses 

Before configuring the link, you must ensure that the two independent links have correctly configured IP 

address details. 

All four radios in the protected link must be on the same subnet. 

 

 

 

Example of MHSB IP addressing 
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Mounting the MHSB Radios and Switches 
 

Once the IP addresses are correctly configured, it is important to connect the A and B radios' Ethernet and 

Alarm ports correctly. In general, mount radio A above the MHSB switch and radio B below the MHSB 

switch: 

 

There is an Ethernet connection between any of the four Ethernet ports on each radio and the Ethernet 

port on the Tributary switch. There is also a connection between radio A and radio B, which ensures 

Ethernet traffic is maintained if a radio loses power. 

The Ethernet port on the protection switch can be connected to an Ethernet hub or switch to allow 

multiple connections. 

Important: The management Ethernet capacity on each of the four radios in the protected terminal must 

be identical for remote communications to work and there should only be one IP connection to the 

management network (via the tributary switch Ethernet port). 
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Configuring the Terminals for MHSB 

It is recommended that you configure the local and remote A side first, then the local and remote B side. 

Both the local A and B radios must be configured identically, and both the remote A and B radios must be 

configured identically. 

Tip: As illustrated below, you may find it helpful to have two browser sessions running simultaneously. 

You can then easily see both the A and B sides of the protected link. 

To configure MHSB operation: 

1. Select Link > Maintenance > MHSB. 
 

 
 

2. Enable MHSB mode. 

3. Select whether the radio is A or B. 

Ensure that the radio connected to the A side of the protection switch (normally above the MHSB 

switch) is set to Radio A and the radio connected to the B side of the protection switch (normally 

below the MHSB switch) is set to Radio B. 

In the event of a power outage, the radios will switch over to the A side of the protection switch when 

the power is restored. The A side is also the default active side. 

 

4. When you have made your changes, click Apply to apply changes or Reset to restore the previous 
configuration. 

5. Repeat steps 2 to 4 for the other side of the protected link. 
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Clearing MHSB Alarms 

If a switchover event occurs, the OK LED on the front panel and on the Terminal status and menu bar in 

SuperVisor changes to amber. 

1. Select Clear Switched Alarm from the MHSB Command drop-down list. 
 

 
 

2. Click Apply to apply changes or Reset to reset the page. 
 

Note: When MHSB mode is enabled, external alarm input 2 is used by the protection system to carry 

alarms from the protection switch to the radio. In MHSB mode, therefore, only external alarm input 1 is 

available for user alarms. 
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Hitless Space Diversity (HSD) 
 

HSD provides hitless RF receive path protection and hot standby transmitter redundancy.  It is typically 

deployed for paths where high path availability is required.  

An Aprisa XE hitless space diversity terminal comprises two radio terminals, radio A and radio B. 

Radio A is the primary radio which is fitted with the interface cards and connects to antenna A. 

Antenna A always carries the transmitted signal and the received signal for Radio A. 

Radio B is the secondary radio the receiver of which connects to antenna B. The transmitter in this radio is 

the standby transmitter. 

In the event of a radio A active transmitter failure, radio B transmitter becomes active. 

Antenna B only carries the received signal for Radio B. This antenna is physically separated on the tower 

by a pre-determined distance from Antenna A. 

As both radios have a receive path, traffic from the path with the best received bit error rate is routed to 

the customer interfaces in radio A. 

In an HSD terminal, a HSD Protection Switch Card (PSC) is always fitted in slot H in Radio A and a HSD 

Protection Interface Card (PIC) is always fitted in slot H in Radio B. The PSC card has a card front switch 

which controls the hardware setting of the HSD system Active Radio (Auto Select, Radio A or Radio B). 

Customer interfaces are provided on radio A only in interface slots A to G. Interface connections to 

Ethernet and the external alarm inputs and outputs are also provided on radio A only. 
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HSD Terminal Cabling 

The two HSD radios are interconnected as follows: 

 

 

 

Cables Supplied with HSD Terminal 
 

The following cables are supplied with a HSD terminal: 

 

RF cable 

A 110 mm QMA female to QMA female low loss RF cable is required to interconnect between the TX ports 

of both radio A and radio B. This cable carries the radio B transmitter output to the radio A transmitter 

switch. 

 

Ethernet Cable 

A 200 mm RJ45 to RJ45 Ethernet cable between the Ethernet ports of radio A and radio B. This cable 

carries management IP traffic between radio A and radio B. 

 

Traffic Cable 

A 200 mm RJ45 to RJ45 Ethernet cable between the PSC and PIC. This cable carries all user traffic 

between Radio A and Radio B. 
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HSD Terminal IP Addresses 

Each radio in the HSD link is assigned a unique IP address. All four radios in the HSD link must be on the 

same subnet. 

The IP address of the four terminals can only be changed by logging into the relevant radio A or radio B. 

When the IP addresses have been setup, an ethernet connection to any of the four radios can access all 

four radios in the HSD link. The usual ethernet connection is to the near end Radio A (see ‘IP Addressing of 

Terminals’ on page 53). 

 

 

 

Example of IP addressing 
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Configuring HSD Terminals 

To simplify the management and configuration of the HSD terminals, SuperVisor provides four windows 

which display the parameters for all four radios, the local and remote, radios A and B. The HSD System 

menu item displays the four windows. 

When a parameter is changed in the four window mode, the relevant parameter is automatically changed 

to the same setting on the corresponding radio e.g. if a radio A modulation type is changed, the radio B 

modulation type is also changed to the same setting. 

The Local and Remote menus continue to display the parameters for the local and remote radios for the 

near end terminal logged into. 

 

 

 

The majority of SuperVisor HSD System pages contain the same parameters and controls as the standard 

1+0 XE terminal. The main exceptions are the HSD Control page and the HSD Performance Summary page. 
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HSD Active Radio Control 

The HSD system ‘Active Radio’ control determines if the selection of Radio A or Radio B is automatic or 

manual. This controls both the radio transmitters and receivers. 

The Active Radio can be set with the hardware switch on the PSC card front or with the SuperVisor 

software control. The last change of hardware / software control determines the state of the HSD system. 

 

The SuperVisor software control will always reflect the state of the HSD system. 

After terminal startup or reboot, the state of the PSC mode switch determines the setting used by the 

system and the SuperVisor software control is set to reflect the state of the HSD system. 

 

The PSC card has two card front LEDs which indicate the status of the HSD system: 

 

PSC Mode 
Switch 

Hardware Control Change Software Control Change 

LED A LED B LED A LED B 

Radio A Solid Amber Off Flashing Amber Off 

Auto Select Solid Green Solid Green Flashing Amber Flashing Amber 

Radio B Off Solid Amber Off Flashing Amber 

 

To set the HSD controls: 

1. Select HSD System > Maintenance > Control. 
 

 
 

2. Set the Active Radio parameter. 
 

Active Radio Mode of Operation 

Auto Select 

(default) 

Automatic mode: 

The hitless receive will select traffic from the receive path of best 
performance 

The HSD system will switch to the standby transmitter if the active 
transmitter fails (TX failure alarm) 

Radio A Only Manual selection of radio path A only for both the transmitter and 
receiver i.e. no automatic switching 

Radio B Only Manual selection of radio path B only for both the transmitter and 
receiver i.e. no automatic switching 

 

Note: There is no timeout for a manual selection of the Active Radio setting (Radio A only or Radio B only) 

but a ‘Mode Switch Software Override’ alarm will warn if the software has overwritten the PSC Mode 

Switch. 
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3. Set the Parameter Compare Checking. 

 

Parameter Compare Checking Option 

On 

(default) 

Any mismatch in parameters shown in Terminal Settings 
between Radio A and Radio B will generate a Parameter 
Mismatch alarm. 

Off No Parameter Mismatch alarm will be generated. 
 

 

To view the HSD System Performance Summary: 

1. Select HSD System > Performance > Summary. 
 

 
 

Field Explanation 

Terminal UCEs The total number of HSD terminal uncorrectable blocks since the last 
reset 

Terminal Errored 
seconds 

The total number of HSD terminal operational seconds with errored 
traffic since the last reset 

Terminal Error free 
seconds 

The total number of HSD terminal error free operational seconds since 
the last reset 

Terminal BER The system will report an estimated HSD terminal Bit Error Rate up to a 
maximum of 1 in 1021 

Active Transmitter Dislays the current active transmitter (TxA or TxB) 

Click Reset Counters to reset the error counters to zero. 
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12. In-Service Commissioning 

Before You Start 

When you have finished installing the hardware, RF and the traffic interface cabling, the system is ready 

to be commissioned. Commissioning the terminal is a simple process and consists of: 

1. Powering up the terminals 

2. Configuring both the local and remote terminals using SuperVisor 

3. Aligning the antennas 

4. Synchronizing the terminals 

5. Testing the link is operating correctly. As a minimum, conduct the suggested tests to ensure correct 
operation. More extensive testing may be required to satisfy the end client or regulatory body 
requirements. 

6. Connecting up the client or user interfaces 

 

What You Will Need 

 Appropriately qualified commissioning staff at both ends of the link. 

 Safety equipment appropriate for the antenna location at both ends of the link. 

 Communication equipment, that is, mobile phones or two-way radios. 

 SuperVisor software running on an appropriate laptop, computer, or workstation at one end of the 

link. 

 Tools to facilitate loosening and re-tightening the antenna pan and tilt adjusters. 

 Predicted receiver input levels and fade margin figures from the radio link budget (You can use 

Surveyor (see ‘Path planning’ on page 23) to calculate the RSSI, fade margin, and availability). 
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Applying Power to the Terminals 

 

 

WARNING: 

Before applying power to a terminal, ensure you have connected the safety 
earth and antenna cable. 

 

Apply power to the terminals at each end of the link.  

When power is first applied, all the front panel LEDs will illuminate red for several seconds as the system 

initializes. 

After the system is initialized, the OK LED on the front panel should illuminate green and if the terminals 

are correctly configured, the TX and RX LED should also be illuminated green. 

 

If the RX LED is: 

 

Red the antennas are may be significantly mis-aligned with no signal being 
received 

Amber the antennas may be roughly aligned with some signal being received 

Green the antennas are well-aligned and adequate signal is being received to create 
a reliable path 

 

If the TX LED is: 

 

Red the transmitter is faulty 

Amber there is a fault in the antenna connection or feeder cable 

Green the transmitter is working normally 

 

Review the Link Configurations Using SuperVisor 
1. Connect a PC, with SuperVisor installed, to both terminals in the link. 

2. Log into the link. 

3. Select Link > Summary and confirm the following basic information: 

 Terminal IP address(es) 

 Terminal TX and RX frequencies 

 RSSI (dBm) 

 TX power (dBm) 

 SNR (dBm) 

 

Note: If the terminals have not already been configured, refer to ‘Configuring the terminal’ on page 69, 

‘Configuring the traffic interfaces’ on page 91, and ‘Configuring the traffic cross connections’ on page 

145. 
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Antenna Alignment 

For any point-to-point link, it is important to correctly align the antennas to maximize the signal strength 

at both ends of the link. Each antenna must be pointing directly at the corresponding antenna at the 

remote site, and they must both be on the same polarization. The antennas are aligned visually, and then 

small adjustments are made while the link is operating to maximize the received signal. 

Directional antennas have a radiation pattern that is most sensitive in front of the antenna, in line with 

the main lobe of the radiation pattern. There are several other lobes (side lobes) that are not as sensitive 

as the main lobe in front of the antenna. 

 

 

 

For the link to operate reliably, it is important that the main lobes of both antennas are aligned. If any of 

the side lobes are aligned to the opposite antenna, the received signal strength of both terminals will be 

lower, which could result in fading. If in doubt, check the radiation patterns of the antennas you are 

using. 

 

Checking the Antenna Polarization 

Check that the polarization of the antennas at each end of the link is the same. 

Antenna polarization of grid antennas are normally indicated by an arrow or with ‘H’ and ‘V’ markers 

(indicating horizontal and vertical). 

On Yagi antennas, ensure the orientation of the elements are the same at each end of the link.  

Transmit frequency and power, and antenna polarization would normally be defined by a regulatory body, 

and typically licensed to a particular user. Refer to your license details when setting the antenna 

polarization. 
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Visually Aligning Antennas 

1. Stand behind the antenna, and move it from side to side until it is pointing directly at the antenna at 
the remote site. The remote antenna may be made more visible by using a mirror, strobe light, or 
flag. 

 

If the remote end of the link is not visible (due to smoke, haze, or local clutter, etc), align the 

antenna by using a magnetic compass. Calculate the bearing using a scale map of the link path.  

 

When setting the antenna on the desired bearing ensure that you use the appropriate true-north to 

magnetic-north offset. Also ensure that the compass reading is not affected by standing too close to 

metallic objects. 

 

 

 

2. Once the antenna is pointing at the remote antenna, tighten the nuts on the U-bolt or antenna clamp 
just enough to hold it in position. Leave the nuts loose enough so that small adjustments can still be 
made. Check that the antenna is still pointing in the correct direction. 

3. Move the antenna up or down until it is pointing directly at the remote site. 

4. Tighten the elevation and azimuth adjustment clamps. 

5. Mark the position of the antenna clamps so that the antenna can be returned to this rough aim point 
easily when accurately aligning the antennas. 

6. Repeat steps 1-5 at the opposite site. 

 

Note: Low gain antennas need less adjustment in elevation as they are simply aimed at the horizon. They 

should always be panned horizontally to find the peak signal. 
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Accurately Aligning the Antennas 

Once the antennas are visually aligned, accurately align both antennas by carefully making small 

adjustments while monitoring the RSSI. This will give the best possible link performance. 

 

Note: Remember that it is important to align the main radiation lobes of the two antennas to each other, 

not any side lobes. It may be easier to perform this procedure if you can communicate with someone at 

the remote site by telephone, mobile, or two-way radio. 

 

1. Connect a laptop PC running SuperVisor software and power up the terminals at both ends of the link. 
Select Link > Performance > Summary so that you can see the RSSI indication for the local terminal. 
Alternatively, use the RSSI test point on the front panel together with a multimeter (see ‘Measuring 
the RSSI’ on page 202). 

2. Move the antenna through a complete sweep horizontally (known as a 'pan') either side of the point 
established in the visual alignment process above. Note down the RSSI reading for all the peaks in RSSI 
that you discover in the pan. 

3. Move the antenna to the position corresponding to the maximum RSSI value obtained during the pan. 
Move the antenna horizontally slightly to each side of this maximum to find the two points where the 
RSSI drops slightly. 

4. Move the antenna halfway between these two points and tighten the clamp. 

5. If the antenna has an elevation adjustment, move the antenna through a complete sweep (known as a 
'tilt') vertically either side of the point established in the visual alignment process above. Note down 
the RSSI reading for all the peaks in RSSI that you discover in the tilt. 

6. Move the antenna to the position corresponding to the maximum RSSI value obtained during the tilt. 
Move the antenna slightly up and then down from the maximum to find the two points where the RSSI 
drops slightly. 

7. Move the antenna halfway between these two points and tighten the clamp. 

8. Recheck the pan (steps 2-4) and tighten all the clamps firmly. 

 

 

 

9. Perform steps 1-8 at the remote site. 

 



202  |  In-Service Commissioning 

 
 

Aprisa XE User Manual 

 

Measuring the RSSI 

Measure the RSSI value with a multimeter connected to the RSSI test port on the front of the terminal (see 

‘Front panel connections and indicators’ on page 31). 

1. Insert the positive probe of the multimeter into the RSSI test port, and clip the negative probe to the 
chassis of the terminal (earth). 

2. Pan and tilt the antenna until you get the highest VDC reading. The values shown in the table below 
relate the measured VDC to the actual received signal level in dBm regardless of bandwidth and 
frequency. 

 

RSSI test 
port value 

(VDC) 

RSSI 
reading 
(dBm) 

 RSSI test 
port value 

(VDC) 

RSSI 
reading 
(dBm) 

 RSSI test 
port value 

(VDC) 

RSSI 
reading 
(dBm) 

0.000 - 100   0.675 - 73  1.350 - 46 

0.025 - 99    0.700 - 72  1.375 - 45 

0.050 - 98    0.725 - 71  1.400 - 44 

0.075 - 97    0.750 - 70  1.425 - 43 

0.100 - 96    0.775 - 69  1.450 - 42 

0.125 - 95    0.800 - 68  1.475 - 41 

0.150 - 94    0.825 - 67  1.500 - 40 

0.175   - 93    0.850 - 66  1.525 - 39 

0.200   - 92    0.875 - 65  1.550 - 38 

0.225   - 91    0.900 - 64  1.575 - 37 

0.250   - 90    0.925 - 63  1.600 - 36 

0.275   - 89    0.950 - 62  1.625 - 35 

0.300   - 88    0.975 - 61  1.650 - 34 

0.325   - 87    1.000 - 60  1.675 - 33 

0.350   - 86    1.025 - 59  1.700 - 32 

0.375   - 85    1.050 - 58  1.725 - 31 

0.400   - 84    1.075 - 57  1.750 - 30 

0.425   - 83    1.100 - 56  1.775 - 29 

0.450   - 82    1.125 - 55  1.800 - 28 

0.475   - 81    1.150 - 54  1.825 - 27 

0.500   - 80    1.175 - 53  1.850 - 26 

0.525   - 79    1.200 - 52  1.875 - 25 

0.550   - 78    1.225 - 51  1.900 - 24 

0.575   - 77    1.250 - 50  1.925 - 23 

0.600 - 76  1.275 - 49  1.950 - 22 

0.625 - 75  1.300 - 48  1.975 - 21 

0.650 - 74  1.325 - 47  2.000 - 20 
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Checking Performance 

The amount of testing performed on the completed installation will depend on circumstances. Some 

customers may need to prove to a local licensing regulatory body that the link complies with the license 

provisions. This may require special telecommunications test equipment to complete these tests. Most 

customers simply want to confirm that their data traffic is successfully passing over the link, or that the 

customer interfaces comply with known quality standard. 

However, the most important performance verification checks are: 

 Receive input level 

 Fade margin 

 Long-term BER 

 

Checking the Receive Input Level 

The received signal strength at the local terminal is affected by many components in the system and has a 

direct relationship with the resulting performance of the link. A link operating with a lower than expected 

signal strength is more likely to suffer from degraded performance during fading conditions. The receive 

input level of a link is normally symmetrical (that is, similar at both ends). 

1. Compare the final RSSI figure obtained after antenna alignment with that calculated for the link. 

2. If the RSSI figure is in excess of 3 dB down on the predicted level, recheck and correct problems using 
the table below and then recheck the RSSI. Alternatively, recheck the link budget calculations. 

 

Possible cause Terminal(s) 

Is the terminal operating on the correct frequency? Local & remote 

Is the remote terminal transmit power correct? Remote 

Are all the coaxial connectors tight? Local & remote 

Is the antenna the correct type, that is, gain and frequency of operation? Local & remote 

Is the antenna polarized? Local & remote 

Is the antenna aligned? Local & remote 

Is the path between the terminals obstructed?  
 

Note: If following the above steps does not resolve the situation, contact Customer Support for 

assistance. 

 

3. Record the RSSI figure on the commissioning form.  

4. Repeat steps 1 to 2 for the other end of the link. 
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Checking the Fade Margin 

The fade margin is affected by many components in the system and is closely related to the received 

signal strength. A link operating with a lower than expected fade margin is more likely to suffer from 

degraded performance during fading conditions. A reduced fade margin can be due to operating the link 

too close to the noise floor, or the presence of external interference. The fade margin of a link can be 

asymmetrical (that is, different at each end). 

Possible causes of low fade margin are as follows: 

 

Problem Terminal 

Low receive signal strength (see above table) Local and Remote 

Interfering signals on the same, or very close to, the frequency of the 
local terminal receiver. 

Local 

Intermodulation products that land on the same or very close to the 
frequency of the local terminal receiver. 

Local or Remote 

Operating near the local receiver noise floor Local 

 

To check the fade margin: 

1. Confirm (and correct if necessary) the receive input level (see the previous test). 

Note: If the receive input level is lower than expected, the fade margin may also be low. 

 

2. Select Link > Performance > Summary and check the current BER of the link in its normal condition is 
better than 10-6 (If necessary, clear out any extraneous errors by clicking Reset Counters).  

3. Check the signal to noise (S/N) indication on the Link > Performance > Summary page. This shows the 
quality of the signal as it is being processed in the modem. It should typically be better than 30 dB. If 
it is less than 25 dB, it means that either the RSSI is very low or in-band interference is degrading the 
S/N performance. 

4. Temporarily reduce the remote site's transmit power using either an external attenuator or SuperVisor 
(Remote > Terminal > Basic). 

Note: Ideally, the transmit power of the remote site should be reduced by up to 20 dB, which will 

require the use of an external 50 ohm coaxial attenuator capable of handling the transmit power 

involved. In the absence of an attenuator, reduce the transmit power using SuperVisor. 

 

5. Check and note the current BER of the link in its now faded condition (Again, if necessary, clear out 
any extraneous errors (introduced by the power reduction step above) by clicking Reset Counters). 

6. Compare the unfaded and faded BER performance of the link (steps 2 and 4). Continue to reduce the 
remote transmit power until either the BER drops to 10-6 or the remote transmitter power has been 
reduced by 20 dB. 

Note: The fade margin of the link is expressed as a number (of dB) that the link can be faded 

(transmitter power reduced) without reducing the BER below operating specifications (1 * 10-6 BER). A 

20 dB fade margin is adequate for most links. 
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7. Record the fade margin and SNR results on the commissioning form. 

Note: If the transmit power is reduced using SuperVisor rather than an external attenuator, the fade 

margin should be recorded as ‘Greater than x dB’ (where x = the power reduction). 

 

8. Restore the remote terminal transmit power to normal. 

9. Repeat steps 1 to 7 for the other end of the link. 

Note: If following all the guidelines above does not resolve the situation, contact Customer Support 

for assistance. 

 

Checking the Long-Term BER 

The BER test is a measure of the stability of the complete link. The BER results of a link can be 

asymmetrical (that is, different at each end). 

1. Select Link > Performance > Summary and check the current BER and error counters of the link. If 
necessary, clear out any extraneous errors by selecting Reset Counters.  

2. Wait 15 minutes, and check the BER display and error counters again. If there are a small number of 
errors and the BER is still better than 1 x 10-9, continue the test for 24 hours. If there are a significant 
number of errors, rectify the cause before completing the 24 hour test. 

Note: It is normal to conduct the BER test in both directions at the same time, and it is important that 

no further work be carried out on the equipment (including the antenna) during this period. 

 

3. The BER after the 24 hour test should typically be better than 1 x 10-8. 

4. Record the BER results on the commissioning form. 

 

Bit Error Rate Tests 

A Bit Error Rate (BER) test can be conducted on the bench, (see ‘Bench Setup’ on page 43). 

Attach the BER tester to the interface port(s) of one terminal, and either another BER tester or a loopback 

plug to the corresponding interface port of the other terminal.  

This BER test can be carried out over the Ethernet, E1 / T1, V.24 or HSS interfaces. It will test the link 

quality with regard to user payload data. 

CAUTION: Do not apply signals greater than -20 dBm to the antenna as they can damage the receiver. In a 

bench setup, there must be 60 - 80 dB at up to 2 GHz of 50 ohm coaxial attenuation (capable of handling 

the transmit power) between the terminals’ antenna connectors. 



206  |  In-Service Commissioning 

 
 

Aprisa XE User Manual 

 

Additional Tests 

Depending on license requirements or your particular needs, you may need to carry out additional tests, 

such as those listed below. 

Refer to the relevant test equipment manuals for test details. 

 

Test Test equipment required 

TX power output measurements (at TX and 
duplexer outputs) 

Power meter 

TX spectrum bandwidth Spectrum analyzer 

TX spectral purity or harmonic outputs Spectrum analyzer 

TX center frequency Frequency counter or spectrum analyzer 

Bulk capacity BER test BER tester 

LAN throughput or errors LAN tester 

G.703 / HDB3 waveforms Digital oscilloscope 

Serial interface BER BER tester 

Audio quality PCM4 or SINAD test set 
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Checking the Link Performance 

For a graphical indication of the link performance, you can use the constellation analyzer. 

The 'dots' are a graphical indication of the quality of the demodulated signal. Small dots that are close 

together indicate a good signal. If the dots become spaced further apart, this indicates that the signal 

quality is degrading. This signal quality degradation can be caused by low Rx signal level due to, for 

example: 

 external interference 

 failure of any of the following: modem, receiver, far end transmitter, an antenna (either end), a 

feeder or connector (for example, due to water damage) 

 path issues such as multipath fading or obstructions 

To check the performance of the link using the constellation analyzer: 

1. Select Link or Local or Remote > Performance > Constellation.  
 

 
 

2. Click Start to start the constellation analyzer. 

While the constellation analyzer is running, the terminal will temporarily stop collecting error 

performance statistics. If you want to run the constellation analyzer anyway, click OK when you see 

this warning message: 

 

3. Click Stop to stop the constellation analyzer. 

The terminal automatically resumes collecting error performance statistics. 
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Viewing a Summary of the Link Performance 

To view the performance summary for a terminal: 

Select Link or Local or Remote > Performance > Summary.  

 

 
 

Field Explanation 

Link Performance 

Correctable errors The total number of correctable blocks since the last reset 

Uncorrectable errors The total number of uncorrectable blocks since the last reset 

SNR (dB) The Signal to Noise Ratio of the link in dB 

RSSI (dBm) The Received Signal Strength Indication at the Rx input in dBm 

Errored seconds The total number of operational seconds with errored traffic since the 
last reset 

Error free seconds The total number of error free operational seconds since the last reset 

BER The system will report an estimated Bit Error Rate up to a maximum of 
1 in 1021 

TX temperature The measured temperature in the transmitter module in °C 

RX temperature The measured temperature in the receiver module in °C 

Ethernet performance 

Transmitted packets The total number of transmitted Ethernet packets 

Received packets The total number of received Ethernet packets 

Received packet errors The total number of packets received with errors 

Click Reset Counters to reset the error counters to zero. 
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Saving the History of the Link Performance 

Link performance history data is stored in a rolling buffer which can be saved as a *.cvs file (default 

filename is savedPerformanceHistory.csv). The maximum history data buffer is 1 week of 1 hour records 

and the last hour is displayed in minute records. 

The parameters saved are: 

 Date / Time 

 SNR (minimum over period) 

 SNR (average over period) 

 SNR (maximum over period) 

 RSSI (minimum over period) 

 RSSI (average over period) 

 RSSI (maximum over period) 

 BER (value at end of period) 

 UCEs count (value at end of period) 

 Transmitter temperature (value at end of period) 
 

To save the history of the link performance for a terminal: 

Select Local > Performance > Save History.  

Example of file (simulated fade data): 

PREVIOUS WEEK

TIME  SNR min

(dB)

 SNR avg

(dB)

 SNR max

(dB)

 RSSI min

(dBm)

 RSSI avg

(dBm)

 RSSI max

(dBm)

 BER  UCEs  Tx Temp

(deg C)

Mon Apr  6 09:44:50 2009 35.14 35.26 35.39 -54.00 -54.00 -54.00 3.40E-12 144 50

Mon Apr  6 10:44:50 2009 35.14 35.26 35.40 -54.00 -53.90 -53.90 3.39E-12 144 50

Mon Apr  6 11:44:50 2009 35.14 35.26 35.40 -54.00 -53.90 -53.90 3.38E-12 144 50

Mon Apr  6 12:44:51 2009 15.31 25.77 58.54 -114.00 -77.00 -54.00 1.58E-05 1045 50

Mon Apr  6 13:44:51 2009 22.52 22.75 22.89 -84.10 -83.70 -83.60 6.92E-06 9912 51

Mon Apr  6 14:44:51 2009 16.20 26.05 54.61 -87.10 -77.40 -60.20 9.67E-05 72125 52

…

PREVIOUS HOUR

TIME  SNR min

(dB)

 SNR avg

(dB)

 SNR max

(dB)

 RSSI min

(dBm)

 RSSI avg

(dBm)

 RSSI max

(dBm)

 BER  UCEs  Tx Temp

(deg C)

Mon Apr  6 14:11:51 2009 22.52 28.38 22.75 -84.10 -78.19 -83.80 5.89E-06 22821 52

Mon Apr  6 14:12:51 2009 22.55 25.67 22.75 -84.10 -80.89 -83.80 5.86E-06 23369 52

Mon Apr  6 14:13:51 2009 22.50 23.52 22.75 -84.10 -83.07 -83.70 5.84E-06 23847 52

Mon Apr  6 14:14:51 2009 22.50 24.35 22.78 -84.10 -82.23 -83.70 5.81E-06 24338 52

Mon Apr  6 14:15:51 2009 22.54 22.73 22.77 -84.10 -83.86 -83.80 5.78E-06 24855 52

Mon Apr  6 14:16:51 2009 22.52 26.67 22.75 -84.10 -79.90 -83.80 5.75E-06 25374 52

Mon Apr  6 14:17:51 2009 22.48 30.19 22.79 -84.10 -76.38 -83.70 5.73E-06 25918 52

Mon Apr  6 14:18:51 2009 22.49 28.87 22.74 -84.10 -77.68 -83.80 5.71E-06 26473 52

Mon Apr  6 14:19:51 2009 22.48 30.65 22.74 -84.10 -75.94 -83.80 5.68E-06 27007 52

Mon Apr  6 14:20:51 2009 22.50 29.99 22.75 -84.00 -76.59 -83.80 5.66E-06 27561 52

Mon Apr  6 14:21:51 2009 22.61 29.78 22.76 -84.00 -76.82 -83.80 5.64E-06 28167 52

Mon Apr  6 14:22:51 2009 22.46 25.70 22.74 -84.10 -80.86 -83.90 5.62E-06 28717 52

Mon Apr  6 14:23:51 2009 22.46 26.96 22.75 -84.10 -79.61 -83.80 5.59E-06 29237 52

Mon Apr  6 14:24:51 2009 22.47 24.71 22.75 -84.10 -81.86 -83.80 5.57E-06 29776 52

Mon Apr  6 14:25:51 2009 22.48 30.19 22.73 -84.10 -76.36 -83.80 5.55E-06 30368 52

Mon Apr  6 14:26:51 2009 22.49 25.97 22.75 -84.20 -80.61 -83.80 5.53E-06 30942 52

Mon Apr  6 14:27:51 2009 16.20 22.94 54.61 -87.10 -83.76 -83.90 7.30E-06 71751 52

Mon Apr  6 14:28:51 2009 16.23 26.84 49.90 -87.00 -73.31 -60.30 6.67E-03 72125 52

Mon Apr  6 14:29:51 2009 35.10 40.60 35.24 -60.50 -54.96 -60.30 1.70E-03 72125 52

Mon Apr  6 14:30:51 2009 35.08 39.17 35.28 -60.50 -56.40 -60.30 9.13E-04 72125 52

Mon Apr  6 14:31:51 2009 35.07 36.63 35.26 -60.50 -58.95 -60.20 6.11E-04 72125 52

Mon Apr  6 14:32:51 2009 35.06 36.68 35.24 -60.60 -58.90 -60.30 4.52E-04 72125 52

Mon Apr  6 14:33:51 2009 35.06 35.34 35.25 -60.60 -60.24 -60.30 3.56E-04 72125 52

Mon Apr  6 14:34:51 2009 35.09 36.28 35.24 -60.50 -59.28 -60.30 2.92E-04 72125 52

Mon Apr  6 14:35:51 2009 35.07 42.56 35.28 -60.60 -53.03 -60.30 2.46E-04 72125 52

…  
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To save the alarm history from the Remote terminal, login to the Remote terminal and Select Local > 

Alarms > Save History. 
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To create an Excel chart of the link performance for a terminal: 

1. Open the *.csv file with Excel.  

2. Select the ‘Time’ column and the column you wish to graph e.g. ‘SNR avg (dB)’ or ‘RSSI avg (dBm)’ 

3. Select ‘Insert Chart’ from the Excel menu. 

 

Graph of Date / Time vs the average SNR 
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Graph of Date / Time vs the average RSSI 
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To clear the history of the link performance for a terminal: 

Select Link or Local or Remote > Performance > Clear History.  
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13. Maintenance 

There are no user-serviceable components within the terminal. 

All hardware maintenance must be completed by 4RF or an authorized service centre. 

Do not attempt to carry out repairs to any boards or parts. 

Return all faulty terminals to 4RF or an authorized service centre.  

For more information on maintenance and training, please contact Customer Services. 

 

CAUTION: Electro Static Discharge (ESD) can damage or destroy the sensitive electrical components in the 

terminal. 

 

Routine Maintenance 

Every six or twelve months, for both ends of the link, you should record the RSSI and SNR levels as well as 

checking the following: 

Item What to check or look for 

Equipment shelter environment Water leaks 
Room temperature 
Excessive vibration 
Vermin damage 

Terminal mounting Firmly mounted 

Antenna cable connections Tight and dry 

Antenna cable and its supports Not loose or suffering from ultra-violet degradation 

Antenna and its mounting hardware Not loose, rusty or damaged 

Safety earth Connections tight 
Cabling intact 

DC system Connections tight 
Voltage in normal limits 

Batteries (if installed) Connections tight 
Electrolyte levels normal 

 



214  |  Maintenance 

 
 

Aprisa XE User Manual 

 

Terminal Upgrades 

You can upgrade all software for both terminals remotely (through a management network), which 

eliminates the need to physically visit either end of the link. 

A terminal is upgraded by accessing a running TFTP server (see ‘TFTP Upgrade Process’ on page 221). All 

the required files are uploaded from the TFTP server into the terminal and then activated following a 

terminal reboot. 

System files can be manually uploaded (see ‘Uploading System Files’ on page 226‘). 

Inventory File 

Software release 8.2.10 and all future software releases, contains an inventory file (similar to a manifest 

file) which is used to validate the software files in the terminal. 

To view the Software Status of the terminal: 

Select Link, Local or Remote > Summary 

 

Software status Function 

Standard Software 
Release 

The software status indicates ‘Standard Software Release’ if the 
following system software files have not been changed since the last 
TFTP Upgrade. 

 Kernel image file 

 Software image file 

 Firmware image files 

 Configuration files 

Modified Software 
Release 

The software status indicates ‘Modified Software Release’ if the system 
software files have been changed since the last TFTP Upgrade. 

This could be caused by: 

 an image file which has been uploaded to the terminal since the 

last TFTP upgrade which is not part of that upgrade.  

 an image file which was part of the last TFTP upgrade but was 

subsequently deleted. 
 

Upgrade Prerequisites 

To minimize disruption of link traffic and prevent your terminals from being rendered inoperative, please 

follow the procedures described in this section together with any additional information or instructions 

supplied with the upgrade package. 

Before upgrading the terminal, ensure that you have saved the configuration file (see ‘Saving the 

terminal's configuration’ on page 89) as well as the cross connection configuration (see ‘Saving cross 

connection configurations’ on page 155). 

The Remote terminal upgrade process will be faster if the bandwidth allocated to the management 

ethernet capacity is maximized. 

The terminal software must be identical at both ends of the link. 

At the end of the terminal upgrade process, the versions of image files (kernel software, and firmware) 

that were in use before the upgrade are still in the terminal. You can restore them, if required, by editing 

the image tables and reactivating the old files (see ‘Changing the Status of an Image ’ on page 232). 

 

IMPORTANT NOTE: Ensure you are logged into the Near end terminal as Admin before you start an 

upgrade. 
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Software Upgrade Process 
 

Unzip and save the following folders to your hard drive: 

 8.6.77 Software 

 tftpd32.exe 

The following steps are required for the software upgrade process: 

1. Identify the correct TFTP upgrade type (see ‘Identifying the Correct TFTP Upgrade Type’ on page 

217). 

2. If the terminals are operating software prior to 8.3.40: 

Upload the Root File System (see ‘Uploading the Root File System’ on page 216) 

Upload the Motherboard Images (see ‘Uploading the Motherboard Images’ on page 216). 

Reboot the terminal. 

3. Go through the steps of the TFTP upgrade process (see ‘TFTP Upgrade Process’ on page 221). 

4. Upgrade for new FXO/FXS and modem images  

5. Reboot the terminal. 

6. Clear the Java and web browser caches (see ‘Step 7: Clear the Java and web browser caches’ on 

page 223). 

 

If the TFTP upload process fails, an ‘Upload Fail’ alarm is raised. If the TFTP upload process fails due to a 

power failure, the alarm is raised upon power recovery. 
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Uploading the Root File System 
 

Note: Uploading of image files can only be performed to the local terminal i.e. not via the link to the 

remote terminal. 

1. Logon to the local terminal as admin. 

2. Go to SuperVisor > Local > Maintenance > Upload > Software. 

3. Browse to the 8.6.77 Software folder and select ‘C-CC-R-8_6_7.img’. 

4. Click Upload and wait for the upload status to display Succeeded. 

5. Activate the ‘C-CC-R-8_6_7.img’ with SuperVisor Local > Maintenance > Image Table (see ‘Changing 

the Status of an Image File’ on page 232). 

 

Uploading the Motherboard Images 
 

The E1 and E2 motherboard images do not update as part of the TFTP upgrade. 

Check if the correct motherboard images are loaded with SuperVisor Local > Maintenance > Image Table. 

 

Example: Radio on V8.4.60 with a Rev C motherboard. 

 

 
 

The Motherboard Firmware images for this software version are: 

 

Motherboard Type Image Files Required 

Rev C C-fpga_E1-0-7-0.img    (Motherboard 1 

C-fpga_E2-0-5-3.img    (Motherboard 2) 

Rev D C-fpga_E1-1-7-3.img    (Motherboard 1 

C-fpga_E2-1-5-4.img    (Motherboard 2) 
 

If the motherboard image files are not correct, upload the relevant image files. 

Note: Uploading of image files can only be performed to the local terminal i.e. not via the link to the 

remote terminal. 

1. Logon to the local terminal as admin  

2. Go to SuperVisor > Local > Maintenance > Upload > Firmware. 

3. Browse to the 8.6.77 Software folder and select ‘C-fpga_Ex-x-x-x.img’. 

4. Click Upload and wait for the upload status to display Succeeded. 

5. Activate the ‘C-fpga_Ex-x-x-x.img’ with SuperVisor Local > Maintenance > Image Table (see ‘Changing 

the Status of an Image File’ on page 232). 
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Identifying the Correct TFTP Upgrade Type 
 

The correct TFTP upgrade type will depend on both the Bootloader Version and the Software Version 

Type. 

Aprisa XE terminals running the older bootloader software (bootloader version 0) have a limitation on the 

number of software images that can be loaded simultaneously into a terminal. 

 

Identifying the Bootloader Version 

Determine which bootloader version your terminal is running by using the SuperVisor menu item 

Maintenance > Support Summary and look for the ‘Bootloader Version’ number: 

 

(1) If your terminal is running bootloader version 1 or greater, use the TFTP full upgrade process. 

(2) If your terminal is running bootloader version 0 and running a software version prior to 7.0.6, 

use the TFTP partial upgrade process. 

(3) If your terminal is running bootloader version 0 and running a software version 7.0.6 or later, 

use the TFTP standard upgrade process. 

(4) HSD terminals cannot run with bootloader version 0. 
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Identifying the Software Version Type 
 

There are six different software version types; ETSI type 1, ETSI type 1 HSD, ETSI type 2, ETSI type 2 HSD, 

FCC Part 101 and FCC Part 90. 

To determine which Software Version Type is currently installed on the terminal, take note of the 

‘Software Version’ on SuperVisor Summary page. The last three characters indicate the Software Version 

Type.  

 

 
 

ETSI Compliance Body 

8_6_77_E0 
The E0 variant supports ETSI (Type 1) 1+0 and MHSB terminals with the same 

variants as Aprisa XE software version 8.4.40. 

8_6_77_E1 
The E1 variant supports ETSI (Type 2) 1+0 and MHSB terminals with the same 

variants as Aprisa XE software version 8.4.40 except for the 400 MHz 25 kHz 
and 50 kHz which has been replaced with 900 MHz 25 kHz and 50 kHz. 

8_6_77_E0h 
The E0h variant supports ETSI (Type 1) Hitless Space Diversity (HSD) 
terminals with the same variants as Aprisa XE software version 8.4.40. 

8_6_77_E1h 
The E1 variant supports ETSI (Type 2) Hitless Space Diversity (HSD) terminals 
with the same variants as Aprisa XE software version 8.4.40 except for the 
400 MHz 25 kHz and 50 kHz which has been replaced with 900 MHz 25 kHz 
and 50 kHz. 

 

FCC Compliance Body 

8_6_77_F0 The F0 variant supports FCC part 90 1+0 and MHSB terminals. 

8_6_77_F0h The F0h variant supports FCC part 90 Hitless Space Diversity (HSD) 
terminals. 

8_6_77_F1 The F1 variant supports FCC part 101 1+0 and MHSB terminals. 

8_6_77_F1h The F1h variant supports FCC part 101 Hitless Space Diversity (HSD) 
terminals. 
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Upgrade Version Files 
 

The following table defines the purpose of the upgrade version files: 

 

Upgrade Version File Upgrade Type Software Version Type 

8_6_77_E0a Full TFTP upgrade ETSI TYPE 1 

8_6_77_E0 Standard TFTP upgrade ETSI TYPE 1 

8_6_77_E0h Standard TFTP upgrade ETSI TYPE 1 HSD 

8_6_77_E0p Partial TFTP upgrade ETSI TYPE 1 

8_6_77_E1a Full TFTP upgrade ETSI TYPE 2 

8_6_77_E1 Standard TFTP upgrade ETSI TYPE 2 

8_6_77_E1h Standard TFTP upgrade ETSI TYPE 2 HSD 

8_6_77_E1p Partial TFTP upgrade ETSI TYPE 2 

8_6_77_F0a Full TFTP upgrade FCC Part 90 

8_6_77_F0 Standard TFTP upgrade FCC Part 90 

8_6_77_F1a Full TFTP upgrade FCC Part 101 

8_6_77_F1 Standard TFTP upgrade FCC Part 101 

 

Installing RF Synthesizer Configuration Files 
 

If you are upgrading from a software version prior to 7_1_x, you will need to install new RF synthesizer 

files, refer to ‘Configuration Files’ on page 226. 

You can then upgrade the terminal using TFTP (see page 221). 

 

Frequency Band Synthesizer File(to be installed) Comments 

300, 400 MHz XE_300_400_type_1_synth.cfg BB synthesizer 

300, 400 MHz XE_300_400_type_2_synth.cfg E3 synthesizer 

300, 400 MHz XE_300_400_type_3_synth.cfg 5 kHz sythesizer step 

600, 700, 800, 900 MHz XE_600_700_800_900_synth.cfg  

1400 MHz XE_1400_synth.cfg  

1400 MHz XE_1400TCVR_synth.cfg New transceiver (introduced 
April 2012) 

1800 MHz XE_1800_synth.cfg  

2000, 2500 MHz XE_2000_2500_synth.cfg  
 



220  |  Maintenance 

 
 

Aprisa XE User Manual 

 

TFTP Upgrade Process Types 
 

TFTP partial upgrade process 

Run the TFTP upgrade process by typing 8_6_77_E0p in the Upgrade Version field. 

This will perform a partial upgrade which will delete unnecessary image files that might be taking up 

space in the Image Table (which could prevent a standard upgrade succeeding). 

Reboot the terminal. 

Run a TFTP standard upgrade process on the terminal. 

Reboot the terminal again. 

 

TFTP standard upgrade process 

This TFTP standard upgrade process excludes FPGA images for the newly introduced revisions of the 

Modem, DFXO and DFXS cards. 

 

Run the TFTP upgrade process by typing ‘8_6_77_E0’ in the Upgrade Version field. 

 

If the standard upgrade fails, it may be necessary to make space for the new images by manually deleting 

‘Inactive’ firmware image files. 

To delete a firmware image file, select the SuperVisor menu item Maintenance > Image Table, select the 

firmware image and click on Edit. Set the IMAGE DETAILS Command to ‘Delete’ and click ‘Apply’. 

Reboot the terminal. 

 

Additional TFTP upgrade options have been provided to load the new images separately. Run the TFTP 

upgrade process using the file: 

 ‘F1_8_6_7’ to load images for the newest DFXO and DFXS cards (rev D). 

 ‘F2_8_6_7’ to load images for all revisions of DFXO and DFXS cards. 

 ‘F3_8_6_7’ to load images for the newest Modem card (rev D). 

Reboot the terminal again. 

 

TFTP full upgrade process 

Run the TFTP upgrade process for 1+0 and MHSB terminals by typing ‘8_6_77_E0a’ in the Upgrade Version 

field. 

Run the TFTP upgrade process for HSD terminals by typing ‘8_6_77_E0h’ in the Upgrade Version field. 

 

Reboot the terminal. 
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TFTP Upgrade Process 
 

To upgrade a terminal using the TFTP: 

1. Run the TFTP server. 

2. Login to the Near end terminal / local terminal (see ‘IP Addressing of Terminals’ on page 53). 

3. Run the TFTP upgrade process on the Remote terminal. 

4. Reboot the Remote terminal. 

5. Run the TFTP upgrade process on the Local terminal. 

6. Reboot the Local terminal. 

7. Clear the Java and web browser caches. 

 

Step 1: Run the TFTP server 

1. Double-click tftpd32.exe (located in the TFTPD directory) from the Aprisa CD supplied with the 
product. Leave the TFTPD32 application running until the end of the upgrade process. 

 

 

2. Click Settings and make sure that both SNTP server and DHCP server are not selected (no tick), and 
click OK. 

 

3. Click Browse and navigate to the root directory on the Aprisa CD (for example, D:\) supplied with the 
product, then click OK. 

 

4. Note down the IP address of the TFTP server (shown in the Server Interfaces drop-down list in the 
TFTPD32 window) as you will need it later. 
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Step 2: Log into the Local terminal 

Use SuperVisor to log into the Near end terminal (now the Local terminal) (see ‘IP Addressing of 

Terminals’ on page 53) with either 'modify' or 'admin' privileges. 

 

Step 3: Run the TFTP upgrade process on the Remote terminal 

1. Select Remote > Maintenance > Upload > TFTP Upgrade. 
 

 
 

2. Enter the IP address of the TFTP server. 

3. Enter the version number of the software that you are upgrading to as a three digit number separated 
by underscores, for example, 8_6_77_E0 for ETSI variants. 

4. Click Apply and check the TFTP server for download activity. 

The Upgrade Result changes from 'Executing' to either 'Succeeded' or 'Failed'. 

Note: This may take several minutes when upgrading the remote terminal. 

If the upgrade has failed: 

 The TFTP server IP address may be set incorrectly 

 The 'Current Directory' on the TFTP server was not pointing to the location of the upload config file 

e.g. 'Rel_8_6_77_E0.cfg' . 

 There may not be enough free space in the image table to write the file. Inactive images can be 

deleted (and the terminal rebooted) to free up space for the new image (see ‘Changing the Status 

of an Image File’ on page 232). 
 

Step 4: Reboot the Remote terminal 

Reboot the remote terminal before proceeding with the next step of the upgrade process (see ‘Rebooting 

the Terminal’ on page 233). 

1. Select Remote > Maintenance > Reboot and select [Hard Reboot] 

Communications to SuperVisor remote page will fail until the remote terminal reboot has completed. 
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Step 5: Run the TFTP upgrade process on the Local terminal. 

1. Select Local > Maintenance > Upload > TFTP Upgrade. 

2. Enter the IP address of the TFTP server (that you noted earlier) 

3. Enter the version number of the software (that you are upgrading to) for example, 8_6_77_E0. 

4. Click Apply and check the TFTP server for download activity. 

The Upgrade Result changes from 'Executing' to either 'Succeeded' or 'Failed'. 

Note: This may take several minutes when upgrading the remote terminal. 

 

Step 6: Reboot the Local terminal 

Reboot the local terminal before proceeding with the next step of the upgrade process (see ‘Rebooting 

the Terminal’ on page 233). 

1. Select Local > Maintenance > Reboot and select [Hard Reboot] 

2. Log back into the Local terminal when the reboot has completed. 

 

Step 7: Clear the Java and web browser caches 

After upgrading the terminal you should clear the Java and web browser caches. The files stored in them 

may cause the SuperVisor and Cross Connections applications to display incorrectly.  

 

To clear the Java cache (Windows XP, Java 1.6): 

1. Select Start > Control Panel. 
 

2. Select Java 

 

 
 

3. Click the General tab. 

4. In the ‘Temporary Internet Files’, click Settings 
 

 
 

5. Click on ‘Delete Files’ (‘Applications and Applets’ and ‘Trace and Log Files’ both ticked) and OK to 
confirm. 
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To clear your web browser cache (Mozilla Firefox 1.x and above): 

1. Select Tools > Options. 

2. Select Privacy and then click Cache. 
 

 
 

3. Click Clear to clear the cache, and then click OK to confirm. 
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To clear your web browser cache (Internet Explorer 7.0 and above): 

1. Select Tools > Internet Options. 

2. On the General tab 
 

 
 

3. In Browsing history, click Delete 

4. In the ‘Temporary Internet Files’, click Delete Files and Yes to confirm. 
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Uploading System Files 
 

System files e.g. configuration files, kernel image files, software image files and firmware image files can 

be uploaded manually. 

 

Note: You should only upgrade components that need changing. It is not always necessary, for instance, to 

replace kernel or software files when upgrading a single firmware file. If interdependency exists between 

file types, this will be made clear in the documentation that accompanied the update package. 

 

Configuration Files 

Configuration files (.cfg) are compressed archives containing a script to instruct the terminal on how to 

handle the other files in the archive. 

Uploading of configuration files can only be performed to the Local Terminal (not via the link to the 

Remote Terminal). 

 

RF synthesizer configuration files 

The RF synthesizer configuration archive contains files that provide values for the transmitter and receiver 

synthesizers to operate across the supported frequency bands. 

Synthesizer configuration filenames have the following format: 
 

XE_(frequency bands)_synth.cfg e.g. XE_300_400_synth.cfg 

 

Modem configuration files 

The Modem configuration archive contains files that provide values for the Modem to operate at the 

various supported channel sizes and modulation types. 

Modem configuration filenames have the following format: 
 

modem_(version number).cfg e.g. modem_8_3_1.cfg (ETSI variants) 

 

Cross-connect configuration files 

The Cross-connect configuration archive contains the Cross Connections application program that can be 

launched from within SuperVisor. 

Cross-connect configuration filenames have the following format: 
 

C-crossconnect_(version number).cfg e.g. C-crossconnect_8_6_7.cfg 
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To upload a configuration file: 

1. Select Local > Maintenance > Config Files > Upload Configuration 

2. Browse to the location of the file required to be uploaded into the terminal *.cfg. 

3. Click on Upload. 
 

 
 

The normal response is Succeeded if the file has been loaded correctly. 

A response of ‘Failed’ could be caused by: 

 Not enough temporary space in the filesystem to uncompress the archive and execute the script 

 A file or directory expected by the script not being present on the filesystem 

 

4. Reboot the terminal using a ‘Hard Reboot’ (see ‘Rebooting the Terminal’ on page 233). 
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Image Files 
 

Image files (.img) are loaded into the terminal and either contains code that is executed by the system 

processor, or contain instructions to configure the various programmable logic elements. The image file 

types that can be uploaded are: 

 Kernel image files 

 Software image files 

 Firmware image files 

 

Note: The Bootloader image file C-CC-B-(version number).srec and Flash File System image file C-CC-F-

(version number).img can only be changed in the factory. 

 

Uploading of image files can only be performed to the local terminal (not via the link to the remote 

terminal). 

 

To upload and activate an image file: 

1. Upload the required image file. 

If the Upload Status page show ‘executing’, then ‘writing to flash’, then ‘Succeeded’, then the file has 

been written into the image table correctly. 

 

 
 

If the Upload Status is ‘Failed’, there may not be enough free space in the image table to write the 

file. Inactive images can be deleted (and the terminal rebooted) to free up space for the new image 

(see ‘Changing the Status of an Image File’ on page 232). 

 

2. Set the status of the image to ‘activate’ (see ‘Changing the Status of an Image ’ on page 232). 

This actually sets the status to ‘Selected’ until after a terminal reboot. 

3. Reboot the terminal using a ‘Hard Reboot’ (see ‘Rebooting the Terminal’ on page 233). 

This activates the selected image. The image table status will now show ‘Active’. 

The previous image file status will now show as ‘Inactive’. 
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Kernel image files 

Kernel image files contain code that forms the basis of the microprocessor’s operating system. There can 

only ever be two kernel image files in the image table, the active and the inactive. 

Kernel filenames have the following format: 
 

C-CC-K-(version number).img e.g. C-CC-K-6_0_0.img 
 

To upload a kernel image file; 

1. Select Local > Maintenance > Upload > Kernel 

2. Browse to the location of the file required to be uploaded into the terminal *.img. 

3. Click on Upload. 
 

 
 

4. Activate the image (see ‘Changing the Status of an Image File’ on page 232). 
 

5. Reboot the terminal using a ‘Hard Reboot’ (see ‘Rebooting the Terminal’ on page 233). 
 

Software image files 

Software image files contain code that forms the basis of the terminal’s application and management 

software (including the Web-based GUI). There can only ever be two software image files in the image 

table, the active and the inactive. 

Software image filenames have the following format: 
 

C-CC-R-(version number).img e.g. C-CC-R-8_6_7.img 
 

To upload a software image file; 

1. Select Local > Maintenance > Upload > Software 

2. Browse to the location of the file required to be uploaded into the terminal *.img. 

3. Click on Upload. 
 

 
 

Software image files may take one or two minutes to upload as they can be quite large (≈ 2 Mbytes). The 

size of this file has caused some Microsoft Internet Explorer proxy server setups to abort during the 

software update process. To avoid this problem, either set the proxy file size limit to 'unlimited' or avoid 

the use of the proxy altogether. 

 

4. Activate the image (see ‘Changing the Status of an Image File’ on page 232). 
 

5. Reboot the terminal using a ‘Hard Reboot’ (see ‘Rebooting the Terminal’ on page 233). 
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Firmware image files 

Firmware image files contain instructions to configure the various programmable logic elements in the 

terminal. There can only ever be two firmware image files for the same HSC version in the image table, 

the active and the inactive. 
 

Firmware image filenames have the following format: 
 

C-fpga_ff-x-y-z.img e.g. C-fpga_E5-0-7-3.img 
 

where ff indicates the function (motherboard, interface card, etc). 

Function Number Function 

E1 Motherboard 1 

E2 Motherboard 2 

E5 QJET Interface Card 

E7 Q4EM Interface Card 

E8 DFXO Interface Card 

E9 DFXS Interface Card 

EA Modem 

EB QV24 Interface Card 

EC HSS Interface Card 

ED PSC (component of HSD system) 

EE PIC (component of HSD system) 

FA HSD modem 

FB QV24 Sync Interface Card 
 

where x indicates the HSC (hardware software compatibility) version. 

where y indicates the firmware major revision number 

where z indicates the firmware minor revision number 

 

To upload a firmware image file; 

1. Select Local > Maintenance > Upload > Firmware 

2. Browse to the location of the file required to be uploaded into the terminal *.img. 

3. Click on Upload. 
 

 
 

4. Activate the image (see ‘Changing the Status of an Image File’ on page 232). 
 

5. Reboot the terminal using a ‘Hard Reboot’ (see ‘Rebooting the Terminal’ on page 233). 
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Viewing the Image Table 
 

To view the image table: 

1. Select Link or Local or Remote > Maintenance > Image Table. 
 

 
 

The image table shows the following information: 

Heading Function 

Index A reference number for the image file 

Type The image type ‘Kernel’, ‘Software’ or ‘Firmware’. 

Status The status of the image; 'Active', 'Inactive', ‘Selected’, ‘Current (de-
selected)’ 

Image Size The image file size in bytes 

Version The image file name and version details 
 

Note: Configuration file details do not appear in the image table. 
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Changing the Status of an Image File 
 

To change the status of an image: 

1. Select Link or Local or Remote > Maintenance > Image Table. 
 

2. Select the image you wish to change and click Edit. 
 

 
 

3. On the Image Details, select the status from the Command drop-down list and click Apply. 
 

Status Function 

Active The image is currently being used by the system. 

Inactive The image is not currently being used by the system and could be 
deleted. 

Selected The image is not currently being used by the system but has been 
activated and will become active following a terminal reboot. 

Current (deselected) The image is currently being used by the system but as another image 
has been selected, it will become inactive following a terminal reboot. 
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Rebooting the Terminal 

The local or remote terminals can be rebooted by SuperVisor. 

You can specify a ‘Soft Reboot’ which reboots the terminal without affecting traffic or a ‘Hard Reboot’ 

which reboots the terminal (similar to power cycling the terminal). 

You can specify an immediate reboot or setup a reboot to occur at a predetermined time. 

 

To reboot the terminal: 

1. Select Link or Local or Remote > Maintenance > Reboot. 
 

 
 

2. Select the Reboot Type field: 
 

Reboot Type Function 

None Does nothing. 

Soft Reboot Reboots the software but does not affect customer traffic. 

Hard Reboot Reboots the entire terminal and affects customer traffic. 
This reboot is similar cycling the power off and on. 

 

3. Select the Reboot Command field: 
 

Reboot Command Function 

None Does nothing 

Reboot Now Execute the selected reboot now 

Timed Reboot Set the Reboot Time field to execute the selected reboot at a later date 
and time. 
This feature can be used to schedule the resulting traffic outage for a 
time that has least customer impact. 

Cancel Reboot Cancel a timed reboot. 
 

4. Click Apply to execute the reboot or Reset to restore the previous configuration. 
 



234  |  Maintenance 

 
 

Aprisa XE User Manual 

 

Support Summary 

The support summary page lists key information about the terminal, for example, serial numbers, 

software version, frequencies and so on. 

To view the support summary: 

Select Link or Local or Remote > Maintenance > Support Summary. 
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Installing Interface Cards 
 

CAUTION: You must power down the terminal before removing or installing interface cards. 

 

Interface cards are initially installed in the factory to the customers’ requirements however, during the 

life of the product, additional interface cards may need to be installed.  

 

Unless the terminals are protected (see ‘Protected terminals’ on page 197), installing new interface cards 

involves a substantial interruption of traffic across the link. Staff performing this task must have the 

appropriate level of education and experience; it should not be attempted by inexperienced personnel.  

 

To install an interface card: 

 

1. Switch off the power to the terminal. 
 

2. Prepare the terminal for new interface cards (see ‘Preparing the Terminal for New Interface Cards’ on 
page 236). 

 

3. Install the interface card (see ‘Installing an Interface Card’ on page 238). 
 

4. Power up the terminal. 
 

5. Configure the slot (see ‘Configuring a Slot’ on page 240). 

A slot can be configured before installing a new interface card, or after the interface card is installed 

and the terminal power cycled. 

 

6. Configure the cross connections. (see ‘Configuring the traffic cross connections’ on page 158) 
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Preparing the Terminal for New Interface Cards 

To prepare the terminal for a new interface card: 

1. Remove the terminal from service by first switching off the terminal power. For an AC powered 
terminal, remove the AC power connector. For a DC powered terminal, switch off the DC circuit 
breaker or supply fuse. 

 

2. Remove all other cables from the terminal, marking their locations first, if necessary, to aid later 
restoration. The safety earth connection must be the last cable removed. 

 

3. Ensure you have unobstructed access to the top and front of the terminal. Remove the terminal from 
the equipment rack, if required. 

 

4. Remove the top cover of the terminal by removing two socket screws from the rear. 

Note: The top cover slides back towards the rear of the chassis. 

 

5. Remove the front fascia by removing the four front panel socket screws. 

Note: The front fascia first hinges out to clear the antenna connector and earth stud, and is then 

removed by unclipping from the chassis and sliding downwards. See illustration below. 
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6. Remove the card securing screw from the required interface slot. 

7. There are two types of interface slot blanking plates, the seven tab break off and the single slot type 
(newer type). 

If the blanking plate is the seven tab break off, remove the slot blanking tab by folding the tab to and 

fro until it breaks off. 

 

 
 

If the blanking plate is the single slot type, unclip the blanking plate from behind the slot (assuming 

that the card securing screw has already been removed). 
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Installing an Interface Card 

To install an interface card: 

1. Remove the interface card from its packaging and static-safe bag. 

CAUTION: To avoid static damage to the terminal or the interface card being installed, use a static 

discharge wristband or similar antistatic device. 

 

2. Offer the interface card into the chassis at an angle until the front panel of the card engages in the 
chassis. 

 

3. Rotate the card in the chassis until it is level, and both parts of the card interface bus connector 
engage with the socket. Push down evenly on the interface card to seat it into the socket. 
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4. Replace the card securing screw. 
 

 
 

Note: Some interface cards may not have the bracket to accept the card securing screw. 

 

5. Replace the fascia and top covers, restore all cables, and power up the terminal. 
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Configuring a Slot 

1. Select Link or Local or Remote > Interface > Slot Summary. 
 

 
 

2. Select the required slot and click Configure Slot. 
 

 
 

'Slot' shows the slot the interface card is plugged into in the terminal (A – H). 

Details of the interface card currently installed in the slot are: 

'HSC’ (hardware software compatibility) A number used by the system software to determine 

which FPGA ‘firmware image file’ to use in the interface card installed. 

'H/W Rev’ (hardware revision). 

 

‘Installed’ field shows the actual interface card installed in the slot. If there is no interface card 

installed in the slot, this field will show ‘none’. 

‘Expected’ shows interface card type that had been previously installed. Interface cards can be setup 

before they are installed in the terminal or after they are installed in the terminal. 

 

3. To setup a new interface card in a slot, select the interface card type you want to fit (or has been 
fitted) from the ‘Expected’ drop-down menu. 

Note: The transmitter, receiver and modem are configured in other sections (see ‘Configuring the 

terminal’ on page 69). 

 

4. Click Apply to apply changes or Reset to restore the previous configuration. 
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14. Troubleshooting 

Loopbacks 

Loopbacks are used as a tool for testing or as part of the commissioning process and will affect customer 

traffic across the link. 

The terminal supports three types of loopbacks:  

 RF radio loopback 

 Interface loopbacks, set at the interface ports 

 Timeslot loopbacks 
 

RF Radio Loopback 

The RF radio loopback provides a loopback connection between the radio TX and radio RX. Each terminal 

is looped back independently. 

 

 
 

All traffic entering the transmit stage of the transceiver is transmitted on the RF link but is also looped 

back to the receiver section of the transceiver. This loopback will affect all traffic through the terminal. 

When the RF loopback is activated, both the radio RX and TX LEDs will flash. 

An RF loopback will automatically deactivate after the period set (in seconds) in the RF Loopback Timeout 

field. The default entry is 3600 seconds (60 minutes). 

When an RF loopback is activated, the ethernet path is disabled to prevent ethernet loopbacks. 

An RF loopback is deactivated if the terminal is rebooted. 

 

To activate or deactivate the RF loopback: 

Select Link or Local or Remote > Maintenance > Loopbacks. 

 

 
 

To activate the RF loopback, tick the RF Loopback checkbox. Untick the checkbox to deactivate it. 

Click Apply to apply changes or Reset to restore the previous configuration. 
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Interface Loopbacks 

The interface loopback provides a loopback connection for the customer-connected equipment. 

These loopbacks are applied on a port-by-port basis and can only be enabled on active ports i.e. the port 

has to be activated by assigning traffic to it by the Cross Connections application. 

These are two types of interface loopbacks: 

Line Facing – port traffic from the customer is transmitted over the RF link but is also looped back to the 

customer 

 

 
 

Radio Facing – traffic received from the RF link is passed to the customer port but is also looped back to 

be transmitted over the RF link. 

 

 
 

Loopback type Description 

QJET 
(whole tributary) 

The QJET interface port has both Line Facing and Radio Facing loopbacks (see 
‘QJET Port Settings’ on page 102). 

The interface card green LED flashes while the loopback is active. 

QJET 
(individual timeslot) 

The Cross Connections application can loopback framed E1 / T1 timeslots (see 
‘Timeslot Loopbacks’ on page 243).  

Q4EM port The Q4EM interface port has both Line Facing and Radio Facing loopbacks (see 
‘Q4EM Port Settings’ on page 104). 

The interface card yellow LED flashes while the loopback is active. 

DFXO port The DFXO interface Line Facing loopback loops back the port data to the 
customer. This loopback is performed on the digital path of the codec. 

The interface card yellow LED flashes while the loopback is active. 

DFXS port The DFXS interface Line Facing loopback loops back the port data to the 
customer. This loopback is performed on the digital path of the codec. 

The interface card yellow LED flashes while the loopback is active. 

HSS port The HSS interface Line Facing loopback loops back the port data to the 
customer. 

The interface card top green LED flashes while the loopback is active. 

QV24 port The QV24 interface Line Facing loopback will loop back the port data to the 
customer. 

Ethernet No loopback possible. 
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Timeslot Loopbacks 

You can loopback framed E1 / T1 timeslots in the Cross Connections application. 

1. Open the Cross Connections application. 

2. Right-click the timeslot you want to loop back. 
 

 
 

3. Select Timeslot Loopback - the looped timeslot will display in black: 
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Alarms 

The LEDs (OK, RX, and TX) on the front panel illuminate either amber or red when there is a fault 

condition: 

 

 Amber indicates a minor alarm that should not affect traffic across the link. 

 Red indicates a major alarm condition that could affect traffic across the link. 

A major or minor alarm can be mapped to the external alarm outputs (see ‘Configuring the External Alarm 

Outputs’ on page 83).  

 

Diagnosing Alarms 

To view the Alarm Summary and their current states: 

Select Link or Local or Remote > Alarms > Summary. 
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Alarm Explanation 

Synthesizer Status The selected transmit frequency is outside the tuning range of the 
transmitter synthesizer 

Modem Lock The terminal modem is not synchronized with the modem at the other end 
of the link 

TX Temp Shutdown The transmitter power amplifier temperature is greater than 75°C. The 
transmitter has shut down to prevent damage. 

TX Temp Warning The transmitter power amplifier temperature is greater than 70°C. The 
transmitter will continue to operate in this condition, but if the power 
amplifier temperature increases above 75°C, a major alarm condition is 
set and the transmitter will shut down to prevent further damage. 

TX AGC Voltage The transmitter power amplifier automatic gain control is out of limits for 
normal operation 

TX Reverse Power There is excessive reflected power at the transmitter port of the terminal, 
indicating a low return loss in the path between transmitter port and the 
antenna. 

TX Return Loss 
Status 

Indicates the difference between the transmitted power and the amount 
of power being reflected back into the terminal. The alarm will trigger 
when there is too much reflected power from the antenna that will 
degrade link performance. 

RX RSSI The RX RSSI alarm threshold is determined by the RSSI Thresholds for each 
of the modulation types (see ‘Setting the RSSI Alarm Threshold’ on page 
80) 

Fan 1 The internal cooling fan 1 is not operating 

Fan 2 The internal cooling fan 2 is not operating 

External Input 1 -2 Indicates an active alarm state on the the external alarm input 

Alarm Output 1 - 4 Indicates an active alarm state on the the external alarm output 

MHSB Switch Indicates that the MHSB has switched over. The MHSB alarm is only shown 
if MHSB mode is enabled (see ‘Configuring the Terminals for MHSB’ on 
page 188). 

 

To view detailed alarm information: 

Select Link or Local or Remote > Alarms > Alarm Table 

 

 
 

The Alarm Table shows the source of the alarm and the type, the slot (and port, if applicable) where the 

alarm originated, the severity and the date and time the alarm occurred.  

To further diagnose the cause of the alarm (see ‘Identifying Causes of Alarms’ on page 250, and ‘Alarm 

Types’ on page 275). 
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Viewing the Alarm History 

The alarm history page shows the historical alarm activity for up to 50 alarms. This page refreshes every 

30 seconds.  

The alarm history for up to 100 alarms can be seen using SNMP (see ‘Configuring SNMP’ on page 85). 

 

To view the alarm history: 

Select Link or Local or Remote > Alarms > Alarm History. 

 

 
 

Field Explanation 

Source The component within the terminal that generated the alarm 

Type The type of alarm (see ‘Alarm types and sources’ on page 275) 

Slot The slot where the alarm originated, if applicable 

Port The port where the alarm originated, if applicable 

Severity Whether the alarm was a major or minor alarm 

Status Whether the alarm is active or cleared 

Time The date and time when the alarm occurred 

 

To clear the alarm history: 

Select Local or Remote > Alarms > Clear History 

This function clears all the alarm history including the 600 alarm rolling buffer (see ‘Saving the Alarm 

History’ on page 247). 
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Saving the Alarm History 

The last 1500 alarms are stored in a rolling buffer which can be saved as a *.csv file. 

 

To save the alarm history: 

Select Local > Alarms > Save History 

A File Download dialog box opens. 

Click on Save to save the *.csv file to a folder or click on Open to open the file in the SuperVisor page. 

 

Example of file: 

 

Source  Type  Slot  Port  Severity  Status  Time  SNR

(dB)

 RSSI

(dBm)

Modem  mdLOS  Aux  -  Major  Active  Tue Jan 22 12:45:54 2008 0 0

Modem  mdTdmAlignmentLost  Aux  -  Major  Active  Tue Jan 22 12:45:54 2008 0 0

Modem  mdDemodAlignmentLost  Aux  -  Major  Active  Tue Jan 22 12:45:54 2008 0 0

QV24  v24CtrlLineLoss  G 1  Major  Active  Tue Jan 22 12:45:55 2008 0 0

QV24  v24CtrlLineLoss  G 2  Major  Active  Tue Jan 22 12:45:55 2008 0 0

QV24  v24CtrlLineLoss  G 3  Major  Active  Tue Jan 22 12:45:55 2008 0 0

System  mdClkSyncFail  ----  -  Major  Active  Tue Jan 22 12:45:57 2008 0 0

Modem  mdLOS  Aux  -  Major  Cleared  Tue Jan 22 12:45:57 2008 0 0

Modem  mdTdmAlignmentLost  Aux  -  Major  Cleared  Tue Jan 22 12:45:57 2008 0 0

Modem  mdDemodAlignmentLost  Aux  -  Major  Cleared  Tue Jan 22 12:45:57 2008 0 0

Transmitter  txADCChZeroLo  Transmitter  -  Minor  Active  Tue Jan 22 12:45:57 2008 0 0

Transmitter  txADCChZeroLo  Transmitter  -  Minor  Cleared  Tue Jan 22 12:45:58 2008 0 0

System  mdClkSyncFail  ----  -  Major  Cleared  Tue Jan 22 12:45:58 2008 0 0

QV24  v24CtrlLineLoss  G 1  Major  Cleared  Tue Jan 22 12:45:59 2008 35.28 0

QV24  v24CtrlLineLoss  G 2  Major  Cleared  Tue Jan 22 12:45:59 2008 35.29 0

QV24  v24CtrlLineLoss  G 3  Major  Cleared  Tue Jan 22 12:45:59 2008 35.26 0

HSS  hssLoss  H 1  Minor  Active  Tue Jan 22 13:51:17 2008 35.28 -52.8

HSS  hssLoss  H 1  Minor  Cleared  Tue Jan 22 13:51:17 2008 35.27 -52.8

QJET  LOS  D 1  Minor  Active  Tue Jan 22 13:51:35 2008 35.29 -52.8  
 

Note: Windows security settings can prevent the download of files. In this case, click on the windows 

security message and select the SuperVisor menu option again (Alarms > Save History). 

 

To save the alarm history from the Remote terminal, login to the Remote terminal and Select Local > 

Alarms > Save History. 
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Viewing Interface Alarms 

To view the alarms for a particular interface: 

1. Select Link or Local or Remote > Interface > Interface Summary. 

2. Select the desired interface card slot from the Interface Summary and click Alarms. 

This opens a page as shown below with a summary of the alarms on the interface card: 

 

 
 

The following fields are displayed: 

 Source: The type of interface card that generated the alarm 

 Type: The type of interface alarm 

 Slot: The slot of the interface card that generated the interface alarm 

 Port: The port that generated the interface alarm 

 Severity: Whether the interface alarm was major or minor 
 

3. Return to the Interface Summary page by either selecting Options > Interface Summary or clicking 
Back in the browser window. 
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Clearing Alarms 

Select Link or Local or Remote > Alarms > Clear Alarms 

 

 
 

MHSB Command 

If a MHSB switchover event occurs, the OK LED on the front panel changes to amber. 

To clear the MHSB switchover alarm: 

Select ‘Clear Switched Alarm’ from the MHSB Command drop-down list and click on Apply. 

 

Image Table Alarm 

An image table alarm occurs if a problem occurred during the boot process which may have left the image 

table in an inconsistent state.  

To clear the image table alarm: 

The default image table alarm: this indicates that the image table has been rebuilt from defaults. This 

can indicate that an incorrect build of software is running on the terminal.  

Select ‘Clear the Default Image Table used alarm’ from the Image Table drop-down list and click on Apply. 

In addition to clearing the image table alarm, you should verify that the active images in the image table 

are correct for the software release. 

 

Upload Alarm 

An Upload Alarm occurs if the TFTP Upgrade process fails. This can indicate that the upgrade process 

cannot find the TFTP server or cannot find the software version number entered.  

To clear the upload alarm alarm: 

Select ‘Clear the Upload Failure Alarm’ from the Upload Alarm drop-down list and click on Apply. 

 



250  |  Troubleshooting 

 
 

Aprisa XE User Manual 

 

Identifying Causes of Alarms 
 

The following are possible causes of an alarm. 

LED Colour Possible causes 

OK Amber A minor system alarm is set 

 Red A major system alarm is set 

RX Amber Low RSSI or AGC limits have been exceeded 

 Red Receiver power supply or synthesizer failure 

TX Amber AGC, transmitter temperature, forward power or reverse power limits 
have been exceeded 

 Red Transmit power supply or synthesizer failure 

 

OK LED 

Colour Alarm condition Suggested action 

Amber Fan failure Check that the fans are not blocked and can spin freely. 

Amber Interface card 
mismatch 

Using SuperVisor, check that the expected interface card and the 
fitted interface card are the same. 

Red Modem lock A modem lock alarm is generally seen when other conditions such 
as low RSSI are present. If there are no other alarms indicated, 
check the following: 

The terminal clocking is set up correctly. 

Both terminals are using the same modulation. 

Both terminals are using the same version of software. 

External RF Interference from equipment operating in adjacent 
channels. 

Check the constellation pattern for evidence of disturbances in 
the RF path. 

Compare RSSI with the expected values from the original path 
engineering calculation. Investigate any large differences. 

If the fault persists, contact your local representative. 

Red Interface alarms Check that the E1 or Ethernet interface cables are fitted 
correctly and the equipment they are connected to is functioning 
correctly. 
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RX LED 

Colour Alarm condition Suggested action 

Amber Low RSSI Check that all antenna and feeder cables are firmly connected 
and not damaged or kinked 

Check there is no damage to the antenna 

Check the TX power and alarm status of the remote terminal 

Amber Receiver AGC Contact your local 4RF representative 

Red Receiver power 
supply 

Contact your local 4RF representative 

 

TX LED 

Colour Alarm condition Suggested action 

Amber Reverse power Check that all antenna and feeder cables are firmly connected 
and not damaged or kinked 

Check there is no damage to the antenna 

Check that the Receiver and Transmitter ports are correctly 
connected to the High and Low ports of the duplexer 

Red Transmitter 
temperature 

Check operation of cooling fan or fans 

Ensure the air grills on the sides of the terminal are clear 

Ensure the ambient air temperature around the equipment is 
less than 50˚C 
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E1 / T1 Alarm Conditions 

The QJET interface yellow LED indicates: 

 Loss of signal (LOS) 

A loss of signal alarm occurs when there is no valid G.703 signal at the E1 / T1 interface RX input from 

the downstream system. 

This alarm masks the LOF and AIS received alarms. 

 

 Loss Of Frame alignment (LOF) 

A loss of frame alignment alarm occurs when the E1 / T1 interface RX input receives a valid G.703 

signal (code and frequency) but does not receive a valid G.704 signal i.e. no frame alignment word, 

from the downstream system (in framed E1 / T1 modes only) (red alarm in framed T1 modes). 

This alarm masks the AIS received alarm. 

 

 Alarm Indication Signal (AIS) 

An AIS received alarm occurs when AIS is received from the downstream system. 

An E1 / T1 interface will output AIS to the downstream system if the normal upstream traffic signal is 

not available e.g. loss of modem synchronization, loss of RF signal across the link (blue alarm in 

framed T1 modes).  

 

 Remote Alarm Indicator (RAI) 

A remote alarm indicator occurs when RAI is received from the downstream system when it has an 

active LOS or LOF alarm (TS0 NFAS bit 3 in framed E1 modes and yellow alarm in framed T1 modes). 

 

 TS16 Loss of signal (TS16LOS) 

A TS16 loss of signal alarm occurs when there is no valid TS16 signal at the E1 interface RX input from 

the downstream system (in E1 PCM 30 modes only). 

 

 TS16 Remote Multi-frame Alarm Indicator (RMAI) 

A remote multiframe alarm indicator occurs when RMAI is received from the downstream system when 

it has an active TS16LOS alarm  (TS16 F0 bit 6 in E1 PCM 30 modes only). 

 

 TS16 Alarm Indication Signal (TS16AIS) 

A TS16 Alarm Indication Signal alarm occurs when AIS is received from the downstream system in TS16. 

An E1 interface will output the TS16 AIS signal to the downstream system if the normal TS16 multi-

frame signal is not available  (in E1 PCM 30 modes only). 

 

The QJET interface green LED indicates: 

The QJET interface green LED flashes when the E1 / T1 port loopback is active. 
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System Log 
 

SuperVisor automatically keeps a log, known as 'syslog', which captures all alarms, errors and events for 

each terminal.  

You can specify that the ‘syslog’ is saved to a particular file (see ‘Setting up for Remote Logging’ on page 

255). You can then email this file to customer service, if requested, to enable them to fault-find more 

accurately. 

Checking the Syslog 

To view the Syslog: 

1. Select Local > Performance > Logging > Syslog. 

This opens a new window: 
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2. The system log is quite hard to decipher in Internet Explorer. If you're using Internet Explorer, select 
View > Source, which opens the file in a more legible layout in Notepad. Save or print this file, as 
required. 

 

 
 

3. If you want to save the system log, you can save it from within Notepad (or Internet Explorer). Select 
File > Save As. Navigate to where you want to save the file. Enter a meaningful filename and select 
'Text File' from the Save As Type drop-down list. Click Save. 

 

You can specify that this file is automatically saved to a computer (see ‘Setting up for Remote Logging’ on 

page 255). 
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Setting up for Remote Logging 

Note: When setting up to save the system log to a specific computer, be aware that the file is constantly 

updated and may get quite large quite quickly. 

 

To set up a terminal for remote logging: 

1. Copy the TFTP server application (tftpd32.exe, which is located in the TFTPD directory) from the 
terminal product CD into a suitable directory on the PC (for example, C:\Program Files\TFTP Server). 

2. Create another directory where you want the system logs to be saved for example; 

C:\Aprisa XE Syslog 

3. Double-click tftpd32.exe. 
 

 
 

4. Click Settings and make sure that both ‘Syslog Server’ and ‘Save syslog message’ boxes are ticked. 
 

 
 

5. Click Browse and select a directory where you want the Syslog file to be saved (created in step 2). 
 

6. Click OK to close the Settings dialog box. 
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7. In SuperVisor, select Link or Link or Local or Remote > Terminal > Advanced. 

 

 

 

8. In the Remote Syslog Address field, enter the IP address of the PC on which the Syslog server is 
running. 

 

9. In the Remote Syslog Port field, enter 514. 

 

10. Reboot the terminal (Link or Local or Remote > Maintenance > Reboot).  

 

11. Open the directory where the system logs are being saved to. You should see a file called syslog.txt. 
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15. Interface Connections 

RJ-45 Connector Pin Assignments 

 

 

RJ-45 pin numbering 

 
 

Interface Traffic Direction 

All interface traffic directions and labels used in this manual refer to the direction relative to the 

terminal. Refer to the diagram below. 

The traffic direction describes the transmit / receive paths and the direction of handshaking and clocking 

signals, depending on the interface. 
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QJET Interface Connections 
 

 

Pin 
number 

Pin function Direction TIA-568A wire colour 

1 Transmit Output Green/white 

2 Transmit Output Green 

3 Not used  Orange/white 

4 Receive Input Blue 

5 Receive Input Blue/white 

6 Not used  Orange 

7 Not used  Brown/white 

8 Not used  Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green On Normal operation 

Yellow On Loss of signal (LOS) or 

Alarm Indication Signal (AIS) or 

Loss Of Frame alignment (LOF) in Framed 
modes 

Green Flashing Port in loopback 

The standard QJET interface is 120 ohm balanced. 

External Balun transformers can be used to provide a 75 ohm unbalanced interface. 
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Ethernet Interface Connections 
 

 

Pin 
number 

Pin function Direction TIA-568A wire 
colour 

1 Transmit Output Green/white 

2 Transmit Output Green 

3 Receive Input Orange/white 

4 Not used  Blue 

5 Not used  Blue/white 

6 Receive Input Orange 

7 Not used  Brown/white 

8 Not used  Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green On Ethernet signal received 

Green Flashing Indicates data traffic present on the interface 

 

Note: Do not connect Power over Ethernet (PoE) connections to the Aprisa XE Ethernet ports as this will 

damage the port. 
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Q4EM Interface Connections 
 

 

Pin 
number 

Pin function Direction TIA-568A wire 
colour 

1 M Input Green/white 

2 M1 Input Green 

3 Receive (Ra/R) Input Orange/white 

4 Transmit (Tb/R1) Output Blue 

5 Transmit (Ta/T1) Output Blue/white 

6 Receive (Rb/T) Input Orange 

7 E Output Brown/white 

8 E1 Output Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green Off No external source applied to M wire (no M 
wire current flowing) 

Green On External source applied to M wire (M wire 
current flowing) 

Green Flashing The interface loopback is active 

Yellow Off E wire relay contact open (no current in 
external device) 

Yellow On E wire relay contact closed  (current flowing 
in external device) 

 



 

Interface Connections  |  261 

 

Aprisa XE User Manual 

 

E&M Signalling Types 

 

The Q4EM E&M signalling leads are optically isolated, bi-directional lines which can be externally 

referenced to meet any of the EIA-464 connection types I, II,IV or V (as shown below). 

The M1 lead associated with the M wire detector can be externally referenced to earth or battery as 

required. 

The E1 lead associated with the E wire output can be externally referenced to earth or battery as 

required. 
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DFXS Interface Connections 
 

 

The subscriber interface connects the terminal to the customer's 2 wire 
telephone via a 2 wire line. 

Each 2 wire channel has two access points: one connects to a customer; the 
other is a local test port. 

 

 

CAUTION: 

If there is a power failure at either terminal, any telephone 
connected at the DFXS will not operate. 

Please ensure that a separate telephone that is not 
dependent on local power is available for use in an 
emergency. 

 

 

RJ-45 Pin number Pin function Direction TIA-568A wire 
colour 

 

1 Not used  Green/white 

2 Not used  Green 

3 Not used  Orange/white 

4 Ring Bi-directional Blue 

5 Tip Bi-directional Blue/white 

6 Not used  Orange 

7 Not used  Brown/white 

8 Not used  Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green Off Interface operational but not in service 

Green On Normal operation 

Green Flashing Cadenced ringing on line 

Yellow Off No interface alarm 

Yellow On Interface alarm 

Yellow Flashing The interface loopback is active 

Both LEDs Flashing Loss of CAS signals 
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DFXO Interface Connections 

 

 

The DFXO interface connects the terminal to the telephone network via a 2 

wire line. 

Each DFXO channel has two access points: one connects to a customer; the 

other is a local test port. 

 

 

RJ-45 Pin number Pin function Direction TIA-568A wire 
colour 

 

1 Not used  Green/white 

2 Not used  Green 

3 Not used  Orange/white 

4 Ring Bi-directional Blue 

5 Tip Bi-directional Blue/white 

6 Not used  Orange 

7 Not used  Brown/white 

8 Not used  Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green Off Interface operational but not in service 

Green On Normal operation 

Green Flashing Cadenced ringing on line 

Yellow Off No interface alarm 

Yellow On Interface alarm 

Yellow Flashing The interface loopback is active 

Both LEDs Flashing Loss of CAS signals 
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HSS Interface Connections 

 

 

The connector on the high-speed synchronous serial interface is a high density 

LFH-60 (as used on standard Cisco WAN port serial interface cables and 

equivalents).  

The interface specification (X.21 / V.35 etc) is automatically changed by simply 

changing the type of interface cable connected to the HSS.  

 

LED indicators 

LED Status Explanation 

Top green LED On Normal operation 

Top green LED Flashing Loopback in place 

Lower green LED On Normal operation 
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Synchronous cable assemblies 
 

RS-449 Serial Cable Assembly for DCE (Part number: Cab Sync 449FC) 

 

Pin number Pin function Direction 

1 Shield Ground - 

4 
22 

SD+ 
SD- 

Input 
Input 

5 
23 

ST+ 
ST- 

Output 
Output 

6 
24 

RD+ 
RD- 

Output 
Output 

7 
25 

RS+ 
RS- 

Input 
Input 

8 
26 

RT+ 
RT- 

Output 
Output 

9 
27 

CS+ 
CS- 

Output 
Output 

10 
37 

LL 
SC 

Input 
_ 

11 
29 

DM+ 
DM- 

Output 
Output 

12 
30 

TR+ 
TR- 

Input 
Input 

13 
31 

RR+ 
RR- 

Output 
Output 

17 
35 

TT+ 
TT- 

Input 
Input 

19 
20 

SG 
RC 

- 
- 
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RS-449 Serial Cable Assembly for DTE (Part number: Cab Sync 449MT) 

 

Pin number Pin function Direction 

1 Shield Ground _ 

4 
22 

SD+ 
SD- 

Output 
Output 

5 
23 

ST+ 
ST- 

Input 
Input 

6 
24 

RD+ 
RD- 

Input 
Input 

7 
25 

RS+ 
RS- 

Output 
Output 

8 
26 

RT+ 
RT- 

Input 
Input 

9 
27 

CS+ 
CS- 

Input 
Input 

10 
37 

LL 
SC 

Output 
_ 

11 
29 

DM+ 
DM- 

Input 
Input 

12 
30 

TR+ 
TR- 

Output 
Output 

13 
31 

RR+ 
RR- 

Input 
Input 

17 
35 

TT+ 
TT- 

Output 
Output 

19 
20 

SG 
RC 

- 
- 
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V.35 Serial Cable Assembly for DCE (Part number: Cab Sync V35FC) 

 

Pin number Pin function Direction 

A Frame Ground  

B Circuit Ground  

C RTS Input 

D CTS Output 

E DSR Output 

F RLSD Output 

H DTR Input 

K LT Input 

P 
S 

SD+ 
SD- 

Input 
Input 

R 
T 

RD+ 
RD- 

Output 
Output 

U 
W 

SCTE+ 
SCTE- 

Input 
Input 

V 
X 

SCR+ 
SCR- 

Output 
Output 

Y 
AA 

SCT+ 
SCT- 

Output 
Output 

 

V.35 Serial Cable Assembly for DTE (Part number: Cab Sync V35MT) 

 

Pin number Pin function Direction 

A Frame Ground  

B Circuit Ground  

C RTS Output 

D CTS Input 

E DSR Input 

F RLSD Input 

H DTR Output 

K LT Output 

P 
S 

SD+ 
SD- 

Output 
Output 

R 
T 

RD+ 
RD- 

Input 
Input 

U 
W 

SCTE+ 
SCTE- 

Output 
Output 

V 
X 

SCR+ 
SCR- 

Input 
Input 

Y 
AA 

SCT+ 
SCT- 

Input 
Input 
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X.21 Serial Cable Assembly for DCE (Part number: Cab Sync X21FC) 

 

Pin number Pin function Direction 

1 Shield Ground - 

2 
9 

Transmit+ 
Transmit- 

Input 
Input 

3 
10 

Control+ 
Control- 

Input 
Input 

4 
11 

Receive+ 
Receive- 

Output 
Output 

5 
12 

Indication+ 
Indication- 

Output 
Output 

6 
13 

Timing+ 
Timing- 

Output 
Output 

8 Circuit Ground  
 

X.21 Serial Cable Assembly for DTE (Part number: Cab Sync X21MT) 

 

Pin number Pin function Direction 

1 Shield Ground - 

2 
9 

Transmit+ 
Transmit- 

Output 
Output 

3 
10 

Control+ 
Control- 

Output 
Output 

4 
11 

Receive+ 
Receive- 

Input 
Input 

5 
12 

Indication+ 
Indication- 

Input 
Input 

6 
13 

Timing+ 
Timing- 

Input 
Input 

8 Circuit Ground  
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RS-530 Serial Cable Assembly for DCE (Part number: Cab Sync 530FC) 

 

Pin number Pin function Direction 

2 
14 

BA(A), TXD+ 
BA(B), TXD- 

Input 
Input 

3 
16 

BB(A), RXD+ 
BB(B), RXD- 

Output 
Output 

4 
19 

CA(A), RTS+ 
CA(B), RTS- 

Input 
Input 

5 
13 

CB(A), CTS+  
CB(B), CTS- 

Output 
Output 

6 
22 

CC(A), DSR+  
CC(B), DSR- 

Output 
Output 

1 
- 

Shield 
- 

 

8 
10 

CF(A), DCD+ 
CF(B), DCD- 

Output 
Output 

15 
12 

DB(A), TXC+ 
DB(B), TXC- 

Output 
Output 

17 
9 

DD(A), RXC+ 
DD(B), RXC- 

Output 
Output 

18 
7 

LL  
Circuit Ground 

Input 
- 

20 
23 

CD(A), DTR+ 
CD(B), DTR- 

Input 
Input 

24 
11 

DA(A), TXCE+ 
DA(B), TXCE- 

Input 
Input 

25 TM, not used Output 
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RS-530 Serial Cable Assembly for DTE (Part number: Cab Sync 530MT) 

 

Pin number Pin function Direction 

2 
14 

BA(A), TXD+ 
BA(B), TXD- 

Output 
Output 

3 
16 

BB(A), RXD+ 
BB(B), RXD- 

Input 
Input 

4 
19 

CA(A), RTS+ 
CA(B), RTS- 

Output 
Output 

5 
13 

CB(A), CTS+  
CB(B), CTS- 

Input 
Input 

6 
22 

CC(A), DSR+  
CC(B), DSR- 

Input 
Input 

1 
- 

Shield 
- 

 

8 
10 

CF(A), DCD+ 
CF(B), DCD- 

Input 
Input 

15 
12 

DB(A), TXC+ 
DB(B), TXC- 

Input 
Input 

17 
9 

DD(A), RXC+ 
DD(B), RXC- 

Input 
Input 

18 
7 

LL  
Circuit Ground 

Output 
- 

20 
23 

CD(A), DTR+ 
CD(B), DTR- 

Output 
Output 

24 
11 

DA(A), TXCE+ 
DA(B), TXCE- 

Output 
Output 

25 TM, not used Output 
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Cable WAN Connectors 
 

Cisco LFH-60 
cable name 

WAN connector Connector gender Label on WAN end 

449FC DB-37 female 'to DTE' 

449MT DB-37 male 'to DCE' 

V35FC M34 female 'to DTE' 

V35MT M34 male 'to DCE' 

X21FC DB-15 female 'to DTE' 

X21MT DB-15 male 'to DCE' 

530FC DB-25 female 'to DTE' 

530MT DB-25 male 'to DCE' 
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QV24 Interface connections 

The QV24 is always configured as a DCE: 

 

RJ45 
Pin number 

Pin function Direction TIA-568A wire 
colour 

1 RTS Input Green / white 

2 DTR Input Green 

3 TXD Input Orange / white 

4 Ground  Blue 

5 Ground  Blue / white 

6 RXD Output Orange 

7 DSR Output Brown / white 

8 CTS Output Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green On / flashing Transmit data 

Yellow On / flashing Receive data 

 

QV24S Interface connections 

The QV24S is always configured as a DCE: 

 

RJ45 
Pin number 

Pin function Direction TIA-568A wire 
colour 

1 RTS Input Green / white 

2 XTXC Input Green 

3 TXD Input Orange / white 

4 Ground  Blue 

5 Ground  Blue / white 

6 RXD Output Orange 

7 RXC Output Brown / white 

8 CTS Output Brown 

 

RJ-45 connector LED indicators 

LED Status Explanation 

Green On / flashing Transmit data 

Yellow On / flashing Receive data 
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16. Alarm Types and Sources 

Alarm Types 

Transmitter Alarms 
 

Transmitter Alarms for all Frequency Bands 

Type Explanation 

tx11VFail The transmitter 11 VDC power supply has failed 

tx28VFail The transmitter 28 VDC power supply has failed 

tx5VFail The transmitter 5 VDC power supply has failed 

txAmplifierBalance One side of the transmitter amplifier has failed 

txEEFail The transmitter on-board memory has failed 

txMibFail The transmitter MIB is corrupt in EEPROM 

txReturnLoss The transmitter return loss is high 

txSynthLD The transmitter synthesizer frequency is not set 

txTSensorFail The transmitter temperature sensor has failed 
 

Transmitter Alarms for 300, 400, 600, 700, 800, 900, 1400 MHz Frequency Bands 

txADCChZeroLo The transmitter AGC voltage is low 

txADCChZeroHi The transmitter AGC voltage is high 

txADCChOneLo The transmitter Forward Power Monitor reading is low 

txADCChOneHi The transmitter Forward Power Monitor reading is high 

txADCChTwoLo The transmitter Reverse Power Monitor reading is low 

txADCChTwoHi The transmitter Reverse Power Monitor reading is high 

txADCChThreeHi The transmitter temperature is greater than 75°C and the 
transmitter has shut down 

txADCChFourLo The transmitter synthesizer tuning voltage is low 

txADCChFourHi The transmitter synthesizer tuning voltage is high 

txADCChFiveLo The transmitter 28 VDC power supply voltage is low 

txADCChFiveHi The transmitter 28 VDC power supply voltage is high 

txADCChSixLo The transmitter 11 VDC power supply voltage is low 

txADCChSixHi The transmitter 11 VDC power supply voltage is high 

txADCChSevenLo The transmitter digital 5 VDC power supply voltage is low 

txADCChSevenHi The transmitter digital 5 VDC power supply voltage is high 

txADCChEightLo The transmitter reference 7 VDC power supply voltage is low 

txADCChEightHi The transmitter reference 7 VDC power supply voltage is high 

txADCChNineLo The transmitter VCO voltage is low 

txADCChNineHi The transmitter VCO voltage is high 

txADCChElevenHi The transmitter temperature is greater than 70°C. 
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Transmitter Alarms for 2000, 2500 MHz Frequency Bands 

txADCChZeroLo The transmitter AGC voltage is low 

txADCChZeroHi The transmitter AGC voltage is high 

txADCChOneLo The transmitter Forward Power Monitor reading is low 

txADCChOneHi The transmitter Forward Power Monitor reading is high 

txADCChTwoLo The transmitter Reverse Power Monitor reading is low 

txADCChTwoHi The transmitter Reverse Power Monitor reading is high 

txADCChThreeHi The transmitter temperature is greater than 75°C and the 
transmitter has shut down 

txADCChFourLo The transmitter synthesizer tuning voltage is low 

txADCChFourHi The transmitter synthesizer tuning voltage is high 

txADCChFiveLo The transmitter 28 VDC power supply voltage is low 

txADCChFiveHi The transmitter 28 VDC power supply voltage is high 

txADCChSixLo The transmitter 9 VDC power supply voltage is low 

txADCChSixHi The transmitter 9 VDC power supply voltage is high 

txADCChSevenLo The transmitter digital 5 VDC power supply voltage is low 

txADCChSevenHi The transmitter digital 5 VDC power supply voltage is high 

txADCChEightLo The transmitter reference -5 VDC power supply voltage is low 

txADCChEightHi The transmitter reference -5 VDC power supply voltage is high 

txADCChNineLo The transmitter VCO voltage is low 

txADCChNineHi The transmitter VCO voltage is high 

txADCChElevenHi The transmitter temperature is greater than 70°C. 
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Receiver Alarms 

 

Receiver Alarms for all Frequency Bands 

Type Explanation 

rx12VFail The receiver 12 VDC power supply has failed 

rxEEFail The on-board memory has failed 

rxMibFail The receiver MIB is corrupt in EEPROM 

rxOff The receiver is off 

rxRSSIHi The receiver maximum input level has been exceeded 

rxRSSILo The RSSI is below the alarm threshold setting (see page 80) 

rxSynthLD The synthesizer frequency is not set 

 

Receiver Alarms for 300, 400, 600, 700, 800, 900 MHz Frequency Bands 

rxADCChZeroLo The receiver 3.3 VDC power supply voltage is low 

rxADCChZeroHi The receiver 3.3 VDC power supply voltage is high 

rxADCChOneLo The receiver synthesizer tuning voltage is low 

rxADCChOneHi The receiver synthesizer tuning voltage is high 

rxADCChTwoLo The receiver +12 VDC power supply is low 

rxADCChTwoHi The receiver +12 VDC power supply is high 

rxADCChThreeLo The receiver +5 VDC power supply is low 

rxADCChThreeHi The receiver +5 VDC power supply is high 

rxADCChFourLo The receiver +12 VDC power supply is low (same alarm as TwoLo) 

rxADCChFourHi The receiver +12 VDC power supply is high (same alarm as TwoHi) 

rxADCChFiveLo The receiver VCO voltage is low 

rxADCChFiveHi The receiver VCO voltage is high 

rxADCChSevenLo The receiver RSSI is lower than the normal operating lower limit 

rxADCChSevenHi The receiver RSSI is higher than the normal operating upper limit 

rxADCChEightLo The receiver temperature is greater than 70°C (below spec) 

rxADCChEightHi The receiver temperature is less than -10°C (below spec) 
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Receiver Alarms for 1400 MHz Frequency Band 

rxADCChZeroLo The receiver 3.3 VDC power supply voltage is low 

rxADCChZeroHi The receiver 3.3 VDC power supply voltage is high 

rxADCChOneLo The receiver synthesizer tuning voltage is low 

rxADCChOneHi The receiver synthesizer tuning voltage is high 

rxADCChTwoLo The receiver -1.5 VDC power supply is low 

rxADCChTwoHi The receiver -1.5 VDC power supply is high 

rxADCChThreeLo The receiver +5 VDC power supply is low 

rxADCChThreeHi The receiver +5 VDC power supply is high 

rxADCChFourLo The receiver +9 VDC power supply is low 

rxADCChFourHi The receiver +9 VDC power supply is high 

rxADCChFiveLo The receiver VCO voltage is low 

rxADCChFiveHi The receiver VCO voltage is high 

rxADCChSevenLo The receiver RSSI is lower than the normal operating lower limit 

rxADCChSevenHi The receiver RSSI is higher than the normal operating upper limit 

rxADCChEightLo The receiver temperature is greater than 70°C (below spec) 

rxADCChEightHi The receiver temperature is less than -10°C (below spec) 
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Receiver Alarms for 2000, 2500 MHz Frequency Bands 

rxADCChZeroLo The receiver 3.3 VDC power supply voltage is low 

rxADCChZeroHi The receiver 3.3 VDC power supply voltage is high 

rxADCChOneLo The receiver synthesizer tuning voltage is low 

rxADCChOneHi The receiver synthesizer tuning voltage is high 

rxADCChTwoLo The receiver +12 VDC power supply is low 

rxADCChTwoHi The receiver +12 VDC power supply is high 

rxADCChThreeLo The receiver +5 VDC power supply is low 

rxADCChThreeHi The receiver +5 VDC power supply is high 

rxADCChFourLo The receiver +9 VDC power supply is low 

rxADCChFourHi The receiver +9 VDC power supply is high 

rxADCChFiveLo The receiver VCO voltage is low 

rxADCChFiveHi The receiver VCO voltage is high 

rxADCChSevenLo The receiver RSSI is lower than the normal operating lower limit 

rxADCChSevenHi The receiver RSSI is higher than the normal operating upper limit 

rxADCChEightLo The receiver temperature is greater than 70°C (below spec) 

rxADCChEightHi The receiver temperature is less than -10°C (below spec) 

 



280  |  Alarm Types and Sources 

 
 

Aprisa XE User Manual 

 

MUX Alarms 

Type Explanation 

muxInit A MUX card failed to program 

muxMibEEFail The MIB EEROM is corrupt 

muxCharEEFail The character data is corrupt 

 

Modem Alarms 

Type Explanation 

mdLOS The modem has loss of synchronization with the far end 

mdDemodAlignmentLost The modem is unable to synchronize to the payload framing 

mdTdmAlignmentLost The modem is unable to synchronize to the system bus timing 

mdRefAFail The modem reference clock A has failed 

mdRefBFail The modem reference clock B has failed 

mdClkSyncFail The modem is unable to synchronize to the system clock 

mdEEFail The modem EEPROM is corrupt 

mdUCEPresent The modem has uncorrectable errors 

 

Motherboard Alarms 

Type Explanation 

mbFan1Fail Fan 1 failure 

mbFan2Fail Fan 2 failure 

mbCardMismatch The expected interface card is different to the card that is fitted 

mbHwHsc A MUX card has an unsupported HSC number 

 



 

Alarm Types and Sources  |  281 

 

Aprisa XE User Manual 

 

QJET Alarms 

Type Explanation 

e1AIS The E1 interface RX input has received an Alarm Indication Signal 
from the downstream equipment. 

e1RAI The E1 interface RX input has received a Remote Alarm Indication 
alarm (RAI) from the downstream equipment. 

A remote alarm indicator signal is sent from the downstream 
equipment when it has an active LOS or LOF alarm. 

e1LOS The E1 interface Loss Of Signal alarm (LOS) 

e1CRC4 The E1 interface Cyclic Redundancy Check 4 alarm indicates a loss 
of or corrupted CRC data. 

e1LOF The E1 interface Loss Of Frame alignment (LOF) 

e1RMAI The E1 interface RX input has received an RMAI from the 
downstream equipment. 

A TS16 remote alarm indicator signal is sent from the downstream 
equipment when it has an active TS16 LOS or LOF alarm. 

e1TS16AIS The E1 interface RX input has received a TS16 Alarm Indication 
Signal from the downstream equipment. 

e1TS16LOS The E1 timeslot 16 Loss Of Signal alarm 

t1AIS The T1 interface RX input has received an Alarm Indication Signal 
from the downstream equipment (AIS Received alarm) 

t1RAI The T1 interface RX input has received a Remote Alarm Indication 
alarm (RAI) from the downstream equipment. 

t1LOS The T1 interface Loss Of Signal alarm (LOS) 

t1LOF The T1 interface Loss Of Frame alignment (LOF) 

 

DFXO Alarms 

Type Explanation 

fxoCodecOvld The DFXO detected a codec receive signal overload 

fxoBillToneOvld The DFXO detected a billing tone input signal overload (greater 
than 0.8 Vrms into 200 Ω) 

fxoUnplug The DFXO detected that the exchange line has been unplugged 
from interface 

fxoCurrentOvld The DFXO Loop current overload detected (greater than 100 mA) 

 

DFXS Alarms 

Type Explanation 

fxsCalibError The phone was off-hook during the DFXS initialization phase 
(during power up) 

fxsDCDCError The DFXS DC-DC converter has a low battery voltage error 

fxsCasLock The DFXS has a loss of CAS lock 
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HSS Alarms 

Type Explanation 

hssLoss The HSS has a loss of control pattern 

hssRxFifoFull The HSS RX FIFO has an overrun 

hssRxFifoEmpty The HSS RX FIFO has an underrun 

hssTxFifoFull The HSS TX FIFO has an overrun 

hssTxFifoEmpty The HSS TX FIFO has an underrun 

hssRxClockInvalid The HSS RX clock is invalid 

hssTxClockInvalid The HSS TX clock is invalid 

 

QV24 Alarms 

Type Explanation 

v24CtrlLineLoss The V.24 control lines are not in sync. 

 

External Alarm Inputs 

Type Explanation 

externalAlarm1 There has been an alarm on external alarm input 1. 

externalAlarm2 There has been an alarm on external alarm input 2. 

 

Remote Terminal Alarms 

Type Explanation 

remoteMajorAlarm There has been a major alarm on the remote terminal. 

remoteMinorAlarm There has been a minor alarm on the remote terminal. 
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Cross Connect Alarms 

Type Explanation 

ccNoBandwidth There is insufficient bandwidth for the current cross connection 
configuration. 

 

MHSB Alarms 

Type Explanation 

mhsbSwitchToStandby The terminal has switched from active to standby. 

 

HSD Alarms 

Type Explanation 

Mode Switch Software 
Override 

This alarm provides a warning if the SuperVisor ‘Active Radio’ HSD 
Control has overwritten the PSC Mode Switch. 

Companion Tx Fail This alarm occurs on Radio A if the Radio B transmitter (HSD 
Companion) has failed. This alarm could be caused by a missing 
RF cable between Radio A and Radio B. 

hsdCompanionLost This alarm occurs if there is no traffic from the HSD Companion 
radio. This alarm could be caused by a missing traffic cable 
between Radio A PSC card and Radio B PIC card. 

pscMuxAlignmentError This alarm occurs if the TDM mux loses alignment to the TDM bus. 
This alarm could be caused by a Radio A PSC hardware failure. 

pscDemuxAlignmentLost This alarm occurs if there is a change in state of the PSC Demux 
alignment. This alarm could be caused by a HSD system receiver 
signal loss (both Radio A and Radio B). 

pscTDMAlignmentLost This alarm occurs if there is a change in state of the PSC TDM 
alignment. This alarm could be caused by a HSD system receiver 
signal loss (both Radio A and Radio B) or a Radio A PSC hardware 
failure. 

hsdParamMismatch This alarm occurs if there is a parameter setting mismatch 
between Radio A and Radio B. 

The Parameter Mismatch alarms only occur if the HSD Control 
‘Parameter Compare Checking’ option is set to ‘On’. 

hsdPMTxPower This alarm occurs if there is a parameter mismatch between 
Radio A and Radio B transmitter power setting. 

hsdPMTermRfChWidth This alarm occurs if there is a parameter mismatch between 
Radio A and Radio B channel size setting. 

hsdPMTxFreq This alarm occurs if there is a parameter mismatch between 
Radio A and Radio B transmitter frequency setting. 

hsdPMRxFreq This alarm occurs if there is a parameter mismatch between 
Radio A and Radio B receiver frequency setting. 

hsdPMTermModState This alarm occurs if there is a parameter mismatch between 
Radio A and Radio B modulation setting. 

hsdPMModemIntlvEna This alarm occurs if there is a parameter mismatch between 
Radio A and Radio B modem interleaver setting. 

 



284  |  Alarm Types and Sources 

 
 

Aprisa XE User Manual 

 

Software Alarms 

Type Explanation 

Upload Fail An Upload Fail alarm occurs if the TFTP Upgrade process fails. 
This can indicate that the upgrade process cannot find the TFTP 
server or cannot find the software version number entered. 

defaultImageTableUsed A default image table alarm indicates that the image table has 
been rebuilt from defaults. This can indicate that an incorrect 
build of software is running on the terminal. 
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17. Country Specific Settings 

The following table shows the country-specific settings for the DFXO / DFXS interface cards. If the country 

you want is not listed, contact the local telephone company for assistance. 

Country DFXO / DFXS Termination / balance 
impedance 

DFXO 
loop 
current 
limiter 

DFXO 
on-hook 
speed 

DFXO 
ringing 
impedance 

DFXO 
ringing 
detection 
threshold 

Argentina 600Ω On < 500 μs > 1 MΩ 16 Vrms 

Australia TN12 220Ω + (820Ω ║ 120nF) On 26 ms > 1 MΩ 16 Vrms 

Austria TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Bahrain TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Belgium TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Brazil 600Ω On < 500 μs > 1 MΩ 16 Vrms 

Bulgaria 220Ω + (820Ω ║ 120nF) On 3 ms > 1 MΩ 16 Vrms 

Canada 600Ω On < 500 μs > 1 MΩ 16 Vrms 

Chile 600Ω On < 500 μs > 1 MΩ 16 Vrms 

China 600Ω and 
China 200Ω + (680Ω ║ 100nF) 

On < 500 μs > 1 MΩ 16 Vrms 

Colombia 600Ω On < 500 μs > 1 MΩ 16 Vrms 

Croatia  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Cyprus TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Czech Republic TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Denmark TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Ecuador 600Ω On < 500 μs > 1 MΩ 16 Vrms 

Egypt TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

El Salvador  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Finland TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

France TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Germany TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Greece TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Guam 600Ω On < 500 μs > 1 MΩ 16 Vrms 

Hong Kong 600Ω On < 500 μs > 1 MΩ 16 Vrms 

Hungary TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Iceland TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

India  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Indonesia  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Ireland  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Israel  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Italy  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Japan  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Jordan  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Kazakhstan  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Kuwait  600Ω On < 500 μs > 1 MΩ 16 Vrms 
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Latvia  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Lebanon  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Luxembourg  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Macao  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Malaysia 600Ω On < 500 μs > 1 MΩ 16 Vrms 

Malta  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Mexico  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Morocco  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Netherlands  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

New Zealand  BT3 (370Ω + (620Ω ║ 310nF)) On < 500 μs > 1 MΩ 16 Vrms 

Nigeria  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Norway TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Oman  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Pakistan  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Peru 600Ω On < 500 μs > 1 MΩ 16 Vrms 

Philippines  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Poland  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Portugal  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Romania  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Russia 600Ω On < 500 μs > 1 MΩ 16 Vrms 

Saudi Arabia  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Singapore  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Slovakia  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Slovenia  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

South Africa  TBR21 270Ω + (750Ω ║ 150nF) On < 500 μs > 12 kΩ 16 Vrms 

South Korea  600Ω On < 500 μs > 12 kΩ 16 Vrms 

Spain  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Sweden TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Switzerland  TBR21 270Ω + (750Ω ║ 150nF) On 3 ms > 1 MΩ 16 Vrms 

Taiwan 600Ω On < 500 μs > 1 MΩ 16 Vrms 

Thailand 600Ω On < 500 μs > 1 MΩ 16 Vrms 

UAE  600Ω On < 500 μs > 1 MΩ 16 Vrms 

UK BT Network 320Ω + (1050Ω ║ 230nF) 
and TBR21 270Ω + (750Ω ║ 150nF) 

On 3 ms > 1 MΩ 16 Vrms 

USA  600Ω On < 500 μs > 1 MΩ 16 Vrms 

Yemen  600Ω On < 500 μs > 1 MΩ 16 Vrms 
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18. Specifications 

 

RF Specifications 

ETSI 

Frequency Bands ETSI 

 

Frequency Bands ETSI

Frequency Bands ETSI
Frequency

Band

Frequency

Tuning Range

Synthesizer

Step Size

300 MHz 330 - 400 MHz 6.25 kHz

400 MHz 394 - 460 MHz 5.0 kHz

400 MHz 400 - 470 MHz 6.25 kHz

600 MHz 620 - 715 MHz 12.5 kHz

800 MHz 805 - 890 MHz 12.5 kHz

900 MHz 850 - 960 MHz 12.5 kHz

1400 MHz 1350 - 1550 MHz 12.5 kHz

1800 MHz 1700 - 2100 MHz 62.5 kHz

2000 MHz 1900 - 2300 MHz 62.5 kHz

2500 MHz 2300 - 2700 MHz 62.5 kHz

Modulation

Frequency stability (short term)

Frequency stability (long term)

Antenna connector

Note 1   Frequency Ranges Country specific frequency ranges within the above tuning ranges can be accommodated

Note 2   Modulation 128 QAM is unreleased: Please contact 4RF for availability.

Note 3   Frequency stability Short term frequency stability is defined as changes in frequency due to environmental effects and power supply 

variations

Long term frequency stability is defined as changes in frequency due to aging of crystal oscillators approx over 5 

years

16 / 32 / 64 / 128 QAM and QPSK (software configurable)

< ±2 ppm

N-type female 50 Ω

< ±1 ppm
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Product Range ETSI 

The Aprisa XE terminal provides the following ETSI frequency bands / channel sizes: 

 

25 50 75 125 150 200 250 500 1.00 1.35 1.75 3.50 7.00 14.00

300

400

600

800

900

1400

1800

2000

2500

112 256 400 640 808 1.02 1.24 2.39 4.89 6.62 8.63 17.18 35.51 65.46

Product Released

Product Release Pending

F
re

q
u
e
n
c
y
 B

a
n
d
 M

H
z

Transport capacity @ 64 QAM 

Channel Size

kHz MHz

kbit/s Mbit/s
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Link Capacity ETSI 

 

Channel size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz Gross 72 kbit/s       96 kbit/s       112 kbit/s       136 kbit/s       

E1 1 timeslot  1 timeslot  1 timeslot  2 timeslots

Wayside 8 kbit/s       32 kbit/s       48 kbit/s       8 kbit/s       

50 kHz Gross 80 kbit/s       168 kbit/s       208 kbit/s       256 kbit/s       296 kbit/s       

E1 1 timeslot  2 timeslots 3 timeslots 4 timeslots 4 timeslots

Wayside 16 kbit/s       40 kbit/s       16 kbit/s       0 kbit/s       40 kbit/s       

75 kHz Gross 128 kbit/s       264 kbit/s       312 kbit/s       400 kbit/s       440 kbit/s       

E1 2 timeslots 4 timeslots 4 timeslots 6 timeslots 6 timeslots

Wayside 0 kbit/s       8 kbit/s       56 kbit/s       16 kbit/s       56 kbit/s       

125 kHz Gross 208 kbit/s       424 kbit/s       536 kbit/s       640 kbit/s       744 kbit/s       

E1 3 timeslots 6 timeslots 8 timeslots 10 timeslots 11 timeslots

Wayside 16 kbit/s       40 kbit/s       24 kbit/s       0 kbit/s       40 kbit/s       

150 kHz Gross 264 kbit/s       536 kbit/s       672 kbit/s       808 kbit/s       944 kbit/s       

E1 4 timeslots 8 timeslots 10 timeslots 12 timeslots 14 timeslots

Wayside 8 kbit/s       24 kbit/s       32 kbit/s       40 kbit/s       48 kbit/s       

200 kHz Gross 336 kbit/s       680 kbit/s       840 kbit/s       1024 kbit/s       1168 kbit/s       

E1 5 timeslots 10 timeslots 13 timeslots 16 timeslots 18 timeslots

Wayside 16 kbit/s       40 kbit/s       8 kbit/s       0 kbit/s       16 kbit/s       

250 kHz Gross 408 kbit/s       824 kbit/s       1032 kbit/s       1240 kbit/s       1448 kbit/s       

E1 6 timeslots 12 timeslots 16 timeslots 19 timeslots 22 timeslots

Wayside 24 kbit/s       56 kbit/s       8 kbit/s       24 kbit/s       40 kbit/s       

500 kHz Gross 792 kbit/s       1592 kbit/s       1992 kbit/s       2392 kbit/s       2792 kbit/s       

E1 12 timeslots 24 timeslots 31 timeslots 1 E1           1 E1           

Wayside 24 kbit/s       56 kbit/s       8 kbit/s       304 kbit/s       704 kbit/s       

1.0 MHz Gross 1624 kbit/s       3256 kbit/s       4072 kbit/s       4888 kbit/s       5704 kbit/s       

E1 25 timeslots 1 E1           1 E1           2 E1s         2 E1s         

Wayside 24 kbit/s       1168 kbit/s       1984 kbit/s       712 kbit/s       1528 kbit/s       

1.35 MHz Gross 2200 kbit/s       4408 kbit/s       5512 kbit/s       6616 kbit/s       7720 kbit/s       

E1 1 E1           2 E1s         2 E1s         3 E1s         3 E1s         

Wayside 112 kbit/s       232 kbit/s       1336 kbit/s       352 kbit/s       1456 kbit/s       

1.75 MHz Gross 2872 kbit/s       5752 kbit/s       7192 kbit/s       8632 kbit/s       10072 kbit/s       

E1 1 E1           2 E1s         3 E1s         4 E1s         4 E1s         

Wayside 784 kbit/s       1576 kbit/s       928 kbit/s       280 kbit/s       1720 kbit/s       

3.5 MHz Gross 5720 kbit/s       11448 kbit/s       14312 kbit/s       17176 kbit/s       20040 kbit/s       

E1 2 E1s         5 E1s         6 E1s         8 E1s         9 E1s         

Wayside 1544 kbit/s       1008 kbit/s       1784 kbit/s       472 kbit/s       1248 kbit/s       

7.0 MHz Gross 11832 kbit/s       23672 kbit/s       29592 kbit/s       35512 kbit/s       41432 kbit/s       

E1 5 E1s         11 E1s         14 E1s         17 E1s         19 E1s         

Wayside 1392 kbit/s       704 kbit/s       360 kbit/s       16 kbit/s       1760 kbit/s       

14 MHz Gross 23992 kbit/s       47992 kbit/s       59992 kbit/s       65464 kbit/s       65400 kbit/s       

E1 11 E1s         22 E1s         28 E1s         28 E1s         28 E1s         

Wayside 1024 kbit/s       2056 kbit/s       1528 kbit/s       7000 kbit/s       6936 kbit/s       

Notes The capacities specified are for Unframed E1 and so require 2088 kbit/s to transport via the radio.

The management ethernet capacity must be subtracted from the gross capacity (default 64 kbit/s).

See Product Range table for Channel Size / Frequency Band cross reference  
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Receiver Sensitivity ETSI 

 

Channel size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA -105 dBm -102 dBm -99 dBm -96 dBm

50 kHz -109 dBm -103 dBm -100 dBm -97 dBm -94 dBm

75 kHz -107 dBm -101 dBm -98 dBm -95 dBm -92 dBm

125 kHz -105 dBm -99 dBm -96 dBm -93 dBm -90 dBm

150 kHz -104 dBm -98 dBm -95 dBm -92 dBm -89 dBm

200 kHz -102 dBm -96 dBm -93 dBm -90 dBm -87 dBm

250 kHz -101 dBm -95 dBm -92 dBm -89 dBm -86 dBm

500 kHz -99 dBm -93 dBm -90 dBm -87 dBm -84 dBm

1.0 MHz -96 dBm -90 dBm -87 dBm -84 dBm -81 dBm

1.35 MHz -95 dBm -89 dBm -86 dBm -83 dBm -80 dBm

1.75 MHz -94 dBm -88 dBm -85 dBm -82 dBm -79 dBm

3.5 MHz -90 dBm -84 dBm -81 dBm -78 dBm -75 dBm

7.0 MHz -87 dBm -81 dBm -78 dBm -75 dBm -72 dBm

14 MHz -84 dBm -78 dBm -75 dBm -72 dBm -69 dBm

Notes Typical performance specified at the antenna port for 10
-6

 BER.

The receiver is typically 1 dB more sensitive for a BER of 10
-3

.

NA (Not Available)  
 

Transmitter Power ETSI 

 

Frequency Band QPSK 16 QAM 32 QAM 64 QAM 128 QAM

300 MHz 21 to 35 dBm 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm

400 MHz 21 to 35 dBm 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm

600 MHz 21 to 35 dBm 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm

800 MHz 21 to 35 dBm 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm

900 MHz 21 to 35 dBm 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm

1400 MHz 21 to 35 dBm 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm

1800 MHz 21 to 35 dBm 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm

2000 MHz 20 to 34 dBm 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm

2500 MHz 20 to 34 dBm 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm  
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System Gain ETSI 

 

Channel Size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA 136 dB 132 dB 128 dB 125 dB

50 kHz 144 dB 134 dB 130 dB 126 dB 123 dB

75 kHz 142 dB 132 dB 128 dB 124 dB 121 dB

125 kHz 140 dB 130 dB 126 dB 122 dB 119 dB

150 kHz 139 dB 129 dB 125 dB 121 dB 118 dB

200 kHz 137 dB 127 dB 123 dB 119 dB 116 dB

250 kHz 136 dB 126 dB 122 dB 118 dB 115 dB

500 kHz 134 dB 124 dB 120 dB 116 dB 113 dB

1.0 MHz 131 dB 121 dB 117 dB 113 dB 110 dB

1.35 MHz 130 dB 120 dB 116 dB 112 dB 109 dB

1.75 MHz 129 dB 119 dB 115 dB 111 dB 108 dB

3.5 MHz 125 dB 115 dB 111 dB 107 dB 104 dB

7.0 MHz 122 dB 112 dB 108 dB 104 dB 101 dB

14 MHz 119 dB 109 dB 105 dB 101 dB 98 dB

Notes Typical performance specified at the antenna port for 10
-6

 BER.

The system gain is typically 1 dB greater for a BER of 10
-3

.

Figures decrease by 1 dB for the 2000 and 2500 MHz bands at QPSK.

System Gain = maximum transmit power - receiver sensitivity

NA (Not Available)  
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Link Delays ETSI 

 

Note: The default Modem Interleaver Mode setting is on for channel sizes of 250 kHz and greater and off 

for channel sizes of 200 kHz and less (see ‘Modem Interleaver Mode’ on page 72). 

 

Typical 1+0, MHSB end-to-end link delay - interleaver off

Channel size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA 51.8 ms 40.6 ms 35.7 ms 30.3 ms

50 kHz 46.2 ms 24.3 ms 20.2 ms 16.9 ms 15.0 ms

75 kHz 30.4 ms 16.2 ms 14.0 ms 11.4 ms 10.6 ms

125 kHz 22.3 ms 12.1 ms 10.0 ms 8.6 ms 7.0 ms

150 kHz 15.9 ms 8.8 ms 7.3 ms 6.4 ms 5.7 ms

200 kHz 12.8 ms 7.2 ms 6.2 ms 5.3 ms 4.9 ms

250 kHz 10.8 ms 6.2 ms 5.3 ms 4.6 ms 4.2 ms

500 kHz 6.3 ms 3.9 ms 3.4 ms 3.1 ms 2.8 ms

1.0 MHz 3.8 ms 2.6 ms 2.3 ms 2.2 ms 2.1 ms

1.35 MHz 3.1 ms 2.3 ms 2.1 ms 2.0 ms 1.9 ms

1.75 MHz 3.1 ms 2.3 ms 2.1 ms 2.0 ms 1.9 ms

3.5 MHz 2.0 ms 1.7 ms 1.6 ms 1.6 ms 1.6 ms

7.0 MHz 1.7 ms 1.5 ms 1.5 ms 1.5 ms 1.4 ms

14 MHz 1.5 ms 1.4 ms 1.4 ms 1.4 ms 1.4 ms

Typical 1+0, MHSB end-to-end link delay - interleaver on

QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA 153.6 ms 118.9 ms 103.5 ms 86.9 ms

50 kHz 138.8 ms 70.5 ms 57.9 ms 47.8 ms 41.8 ms

75 kHz 90.3 ms 46.1 ms 39.5 ms 31.4 ms 28.8 ms

125 kHz 65.6 ms 33.7 ms 27.3 ms 23.1 ms 17.8 ms

150 kHz 45.8 ms 23.7 ms 19.3 ms 16.4 ms 14.3 ms

200 kHz 36.5 ms 19.0 ms 15.8 ms 13.2 ms 11.8 ms

250 kHz 30.4 ms 16.0 ms 13.1 ms 11.2 ms 9.8 ms

500 kHz 16.5 ms 9.0 ms 7.5 ms 6.5 ms 5.7 ms

1.0 MHz 8.8 ms 5.1 ms 4.3 ms 3.9 ms 3.5 ms

1.35 MHz 6.8 ms 4.1 ms 3.6 ms 3.2 ms 2.9 ms

1.75 MHz 5.6 ms 3.5 ms 3.1 ms 2.8 ms 2.9 ms

3.5 MHz 3.5 ms 2.4 ms 2.2 ms 2.1 ms 2.0 ms

7.0 MHz 2.4 ms 1.9 ms 1.8 ms 1.7 ms 1.7 ms

14 MHz 1.9 ms 1.6 ms 1.6 ms 1.5 ms 1.5 ms

Notes The end to end link delays are measured from E1 / T1 interface to E1 / T1 interface 

The delay figures are typical and can vary when the system re-synchronizes

NA (Not Available)  
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Typical HSD end-to-end link delay - interleaver on

QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA 305.4 ms 223.2 ms 202.2 ms NA

50 kHz 247.1 ms 142.0 ms 122.1 ms 95.2 ms NA

75 kHz 185.3 ms 95.8 ms 82.8 ms 67.0 ms NA

125 kHz NA NA NA NA NA

150 kHz 93.3 ms 47.3 ms 39.5 ms 33.7 ms NA

200 kHz 75.6 ms 38.9 ms 32.7 ms 25.5 ms NA

250 kHz 63.6 ms 32.8 ms 25.2 ms 21.6 ms NA

500 kHz 34.0 ms 17.0 ms 14.8 ms 11.4 ms NA

1.0 MHz 16.9 ms 9.5 ms 8.0 ms 6.5 ms NA

1.35 MHz NA NA NA NA NA

1.75 MHz 9.9 ms 5.1 ms 4.9 ms 4.4 ms NA

3.5 MHz 5.5 ms 3.5 ms 3.1 ms 3.1 ms NA

7.0 MHz 3.6 ms 2.5 ms 2.3 ms 2.3 ms NA

14 MHz 2.4 ms 2.0 ms 2.0 ms 2.0 ms NA

Notes The end to end link delays are measured from E1 / T1 interface to E1 / T1 interface 

The delay figures are typical and can vary when the system re-synchronizes

NA (Not Available)  
 



294  |  Specifications 

 
 

Aprisa XE User Manual 

 

FCC 

Frequency Bands FCC 

 

Frequency Bands FCC
Frequency

Band

Frequency

Tuning Range

Synthesizer

Step Size

400 MHz 421 - 512 MHz 6.25 kHz

  700 MHz 698 - 806 MHz 12.5 kHz

900 MHz 928 - 960 MHz 12.5 kHz

2500 MHz 2314 - 2350 MHz 62.5 kHz

Modulation

Frequency stability (short term)

Frequency stability (long term)

Antenna connector

Note 1   Frequency bands Contact 4RF for other frequency band options

Note 2   Modulation 128 QAM is unreleased: Please contact 4RF for availability.

Note 3   Frequency stability Short term frequency stability is defined as changes in frequency due to environmental effects and power supply variations

Long term frequency stability is defined as changes in frequency due to aging of crystal oscillators approx over 5 years

16 / 32 / 64 / 128 QAM and QPSK (software configurable)

< ±2 ppm

N-type female 50 Ω

< ±1 ppm

 

 

Product Range FCC 

The Aprisa XE terminal provides the following FCC frequency bands / channel sizes: 

 

MHz

25 100 200 250 500 1.00

400 Part 90

700 Part 27 Part 27

900 Part 101 Part 101

2500 Part 27 Part 27

88 424 952 1.24 2.39 4.98

Mbit/s

Promoted

Product Release Pending

F
re

q
u
e
n
c
y
 B

a
n
d
 M

H
z

kHz

Channel Size

kbit/s

Transport capacity @ 64 QAM 
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Link Capacity FCC 

Channel size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz Gross 56 kbit/s       72 kbit/s       88 kbit/s       104 kbit/s       

T1 0 timeslots 1 timeslot  1 timeslot  1 timeslot  

Wayside 56 kbit/s       8 kbit/s       24 kbit/s       40 kbit/s       

100 kHz Gross 136 kbit/s       280 kbit/s       352 kbit/s       424 kbit/s       608 kbit/s       

T1 2 timeslots 4 timeslots 5 timeslots 6 timeslots 9 timeslots

Wayside 8 kbit/s       24 kbit/s       32 kbit/s       40 kbit/s       32 kbit/s       

200 kHz Gross 312 kbit/s       632 kbit/s       792 kbit/s       952 kbit/s       1112 kbit/s       

T1 4 timeslots 9 timeslots 12 timeslots 14 timeslots 17 timeslots

Wayside 56 kbit/s       56 kbit/s       24 kbit/s       56 kbit/s       24 kbit/s       

250 kHz Gross 408 kbit/s       824 kbit/s       1032 kbit/s       1240 kbit/s       1448 kbit/s       

T1 6 timeslots 12 timeslots 16 timeslots 19 timeslots 22 timeslots

Wayside 24 kbit/s       56 kbit/s       8 kbit/s       24 kbit/s       40 kbit/s       

500 kHz Gross 792 kbit/s       1592 kbit/s       1992 kbit/s       2392 kbit/s       2792 kbit/s       

T1 12 timeslots 1 T1           1 T1           1 T1           1 T1           

Wayside 24 kbit/s       8 kbit/s       408 kbit/s       808 kbit/s       1208 kbit/s       

1.0 MHz Gross 1656 kbit/s       3320 kbit/s       4152 kbit/s       4984 kbit/s       5816 kbit/s       

T1 1 T1           2 T1s         2 T1s         3 T1s         3 T1s         

Wayside 72 kbit/s       152 kbit/s       984 kbit/s       232 kbit/s       1064 kbit/s       

Notes The capacities specified are for Unframed T1 and so require 1584 kbit/s to transport via the radio.

The management ethernet capacity must be subtracted from the gross capacity (default 64 kbit/s).

See Product Range table for Channel Size / Frequency Band cross reference  
 

Receiver Sensitivity FCC 

Channel Size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA -105 dBm -102 dBm -99 dBm -96 dBm

100 kHz -106 dBm -100 dBm -97 dBm -94 dBm -91 dBm

200 kHz -102 dBm -96 dBm -93 dBm -90 dBm -87 dBm

250 kHz -101 dBm -95 dBm -92 dBm -89 dBm -86 dBm

500 kHz -99 dBm -93 dBm -90 dBm -87 dBm -84 dBm

1.0 MHz -96 dBm -90 dBm -87 dBm -84 dBm -81 dBm

Notes Typical performance specified at the antenna port for 10
-6

 BER.

The receiver is typically 1 dB more sensitive for a BER of 10
-3

.  
 

Transmit Power FCC 

Frequency Band QPSK 16 QAM 32 QAM 64 QAM 128 QAM

400 MHz NA 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm

700 MHz 21 to 35 dBm 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm

900 MHz 15 to 29 dBm 15 to 29 dBm 15 to 29 dBm 15 to 29 dBm 15 to 29 dBm

2500 MHz 15 to 29 dBm 15 to 29 dBm 15 to 29 dBm 15 to 29 dBm 15 to 29 dBm  
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System Gain FCC 

400 MHz, 700 MHz, 900 MHz

Channel Size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA 136 dB 132 dB 128 dB 125 dB

100 kHz 135 dB 129 dB 126 dB 123 dB 120 dB

200 kHz 131 dB 125 dB 122 dB 119 dB 116 dB

500 kHz 134 dB 124 dB 120 dB 116 dB 113 dB

1.0 MHz 131 dB 121 dB 117 dB 113 dB 110 dB

2500 MHz

QPSK 16 QAM 32 QAM 64 QAM 128 QAM

250 kHz 130 dB 124 dB 121 dB 118 dB 115 dB

500 kHz 128 dB 122 dB 119 dB 116 dB 113 dB

Notes Typical performance specified at the antenna port for 10
-6

 BER.

The system gain is typically 1 dB greater for a BER of 10
-3

.

System Gain = maximum transmit power - receiver sensitivity  
 

Link Delays FCC 

Note: The default Modem Interleaver Mode setting is on for channel sizes of 250 kHz and greater and off 

for channel sizes of 200 kHz and less (see ‘Modem Interleaver Mode’ on page 72). 

 

Interleaver off

Channel size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA 64.4 ms 52.3 ms 44.2 ms 38.5 ms

100 kHz 28.8 ms 15.3 ms 12.7 ms 10.9 ms 8.2 ms

200 kHz 15.9 ms 8.8 ms 7.3 ms 6.4 ms 5.1 ms

250 kHz 11.2 ms 6.6 ms 5.4 ms 5.0 ms 4.2 ms

500 kHz 5.9 ms 3.5 ms 3.4 ms 3.2 ms 2.8 ms

1.0 MHz 3.8 ms 2.6 ms 2.3 ms 2.2 ms 2.1 ms

Interleaver on

Channel size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA 191.6 ms 154.1 ms 129.1 ms 111.2 ms

100 kHz 85.3 ms 43.6 ms 35.3 ms 29.7 ms 21.4 ms

200 kHz 45.8 ms 23.7 ms 19.3 ms 16.4 ms 12.3 ms

250 kHz 33.2 ms 17.5 ms 14.3 ms 12.1 ms 9.8 ms

500 kHz 17.5 ms 9.3 ms 8.0 ms 6.9 ms 5.7 ms

1.0 MHz 8.8 ms 5.1 ms 4.3 ms 3.9 ms 3.5 ms

Notes The end to end link delays are measured from E1 / T1 interface to E1 / T1 interface 

The delay figures are typical and can vary when the system re-synchronizes  
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Industry Canada 

Frequency Bands IC 

Frequency Bands IC
Frequency

Band

Frequency

Tuning Range

Synthesizer

Step Size

400 MHz 400 - 470 MHz 6.25 kHz

900 MHz 928 - 960 MHz 12.5 kHz

2000 MHz 1900 - 2300 MHz 62.5 kHz

Modulation

Frequency stability (short term)

Frequency stability (long term)

Antenna connector

Note 1   Frequency bands Contact 4RF for other frequency band options

Note 2   Modulation 128 QAM is unreleased: Please contact 4RF for availability.

Note 3   Frequency stability Short term frequency stability is defined as changes in frequency due to environmental effects and power supply 

variations

Long term frequency stability is defined as changes in frequency due to aging of crystal oscillators approx over 5 

years

< ±1 ppm

16 / 32 / 64 / 128 QAM and QPSK (software configurable)

< ±2 ppm

N-type female 50 Ω

 

 

Product Range IC 

The Aprisa XE terminal provides the following Industry Canada frequency bands / channel sizes: 

 

25 75 100 150 200 500 1.00 1.75 3.50 7.00 14.00

400

900

2000

88 400 424 808 952 2.39 4.89 8.63 17.18 35.51 65.46

F
re

q
 B

a
n
d

Channel Size

Transport capacity @ 64 QAM

kHz MHz

kbit/s Mbit/s
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Link Capacity IC 

Channel size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz Gross NA 56 kbit/s       72 kbit/s       88 kbit/s       NA

T1 0 timeslots 1 timeslot  1 timeslot  

Wayside 56 kbit/s       8 kbit/s       24 kbit/s       

75 kHz Gross 128 kbit/s       264 kbit/s       312 kbit/s       400 kbit/s       440 kbit/s       

T1 2 timeslots 4 timeslots 4 timeslots 6 timeslots 6 timeslots

Wayside 0 kbit/s       8 kbit/s       56 kbit/s       16 kbit/s       56 kbit/s       

100 kHz Gross 136 kbit/s       280 kbit/s       352 kbit/s       424 kbit/s       608 kbit/s       

T1 2 timeslots 4 timeslots 5 timeslots 6 timeslots 9 timeslots

Wayside 8 kbit/s       24 kbit/s       32 kbit/s       40 kbit/s       32 kbit/s       

150 kHz Gross 264 kbit/s       536 kbit/s       672 kbit/s       808 kbit/s       944 kbit/s       

T1 4 timeslots 8 timeslots 10 timeslots 12 timeslots 14 timeslots

Wayside 8 kbit/s       24 kbit/s       32 kbit/s       40 kbit/s       48 kbit/s       

200 kHz Gross 312 kbit/s       632 kbit/s       792 kbit/s       952 kbit/s       1112 kbit/s       

T1 4 timeslots 9 timeslots 12 timeslots 14 timeslots 17 timeslots

Wayside 56 kbit/s       56 kbit/s       24 kbit/s       56 kbit/s       24 kbit/s       

500 kHz Gross 792 kbit/s       1592 kbit/s       1992 kbit/s       2392 kbit/s       2792 kbit/s       

T1 12 timeslots 1 T1           1 T1           1 T1           1 T1           

Wayside 24 kbit/s       8 kbit/s       408 kbit/s       808 kbit/s       1208 kbit/s       

1.0 MHz Gross 1624 kbit/s       3256 kbit/s       4072 kbit/s       4888 kbit/s       5704 kbit/s       

T1 1 T1           2 T1s         2 T1s         3 T1s         3 T1s         

Wayside 40 kbit/s       88 kbit/s       904 kbit/s       136 kbit/s       952 kbit/s       

1.75 MHz Gross 2872 kbit/s       5752 kbit/s       7192 kbit/s       8632 kbit/s       10072 kbit/s       

T1 1 T1           3 T1s         4 T1s         5 T1s         6 T1s         

Wayside 1288 kbit/s       1000 kbit/s       856 kbit/s       712 kbit/s       568 kbit/s       

3.5 MHz Gross 5720 kbit/s       11448 kbit/s       14312 kbit/s       17176 kbit/s       20040 kbit/s       

T1 3 T1s         7 T1s         9 T1s         10 T1s         12 T1s         

Wayside 968 kbit/s       360 kbit/s       56 kbit/s       1336 kbit/s       1032 kbit/s       

7.0 MHz Gross 11832 kbit/s       23672 kbit/s       29592 kbit/s       35512 kbit/s       41432 kbit/s       

T1 7 T1s         14 T1s         18 T1s         22 T1s         26 T1s         

Wayside 744 kbit/s       1496 kbit/s       1080 kbit/s       664 kbit/s       248 kbit/s       

14 MHz Gross NA 47992 kbit/s       59992 kbit/s       65464 kbit/s       65400 kbit/s       

T1 30 T1s         32 T1s         32 T1s         32 T1s         

Wayside 472 kbit/s       9304 kbit/s       14776 kbit/s       14712 kbit/s       

Notes The capacities specified are for Unframed T1 and so require 1584 kbit/s to transport via the radio.

The management ethernet capacity must be subtracted from the gross capacity (default 64 kbit/s).

See Product Range table for Channel Size / Frequency Band cross reference 

NA (Not Available)  
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Receiver Sensitivity IC 

Channel size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA -105 dBm -102 dBm -99 dBm NA

75 kHz -107 dBm -101 dBm -98 dBm -95 dBm -92 dBm

100 kHz -106 dBm -100 dBm -97 dBm -94 dBm -91 dBm

150 kHz -104 dBm -98 dBm -95 dBm -92 dBm -89 dBm

200 kHz -102 dBm -96 dBm -93 dBm -90 dBm -87 dBm

500 kHz -99 dBm -93 dBm -90 dBm -87 dBm -84 dBm

1.0 MHz -96 dBm -90 dBm -87 dBm -84 dBm -81 dBm

1.75 MHz -94 dBm -88 dBm -85 dBm -82 dBm -79 dBm

3.5 MHz -90 dBm -84 dBm -81 dBm -78 dBm -75 dBm

7.0 MHz -87 dBm -81 dBm -78 dBm -75 dBm -72 dBm

14 MHz NA -78 dBm -75 dBm -72 dBm -69 dBm

Notes Typical performance specified at the antenna port for 10
-6

 BER.

The receiver is typically 1 dB more sensitive for a BER of 10
-3

.

NA (Not Available)  
 

Transmitter Power IC 

Frequency Band QPSK 16 QAM 32 QAM 64 QAM 128 QAM

400 MHz 15 to 35 dBm 15 to 31 dBm 15 to 30 dBm 15 to 29 dBm 15 to 29 dBm

900 MHz 15 to 29 dBm 15 to 29 dBm 15 to 29 dBm 15 to 29 dBm 15 to 29 dBm

2000 MHz 20 to 34 dBm 17 to 31 dBm 16 to 30 dBm 15 to 29 dBm 15 to 29 dBm  
 

System Gain IC 

Channel Size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA 136 dB 132 dB 128 dB NA

75 kHz 142 dB 132 dB 128 dB 124 dB 121 dB

100 kHz 135 dB 129 dB 126 dB 123 dB 120 dB

150 kHz 139 dB 129 dB 125 dB 121 dB 118 dB

200 kHz 131 dB 125 dB 122 dB 119 dB 116 dB

500 kHz 133 dB 124 dB 120 dB 116 dB 113 dB

1.0 MHz 130 dB 121 dB 117 dB 113 dB 110 dB

1.75 MHz 128 dB 119 dB 115 dB 111 dB 108 dB

3.5 MHz 124 dB 115 dB 111 dB 107 dB 104 dB

7.0 MHz 121 dB 112 dB 108 dB 104 dB 101 dB

14 MHz NA 109 dB 105 dB 101 dB 98 dB

Notes Typical performance specified at the antenna port for 10
-6

 BER.

The system gain is typically 1 dB greater for a BER of 10
-3

.

System Gain = maximum transmit power - receiver sensitivity

NA (Not Available)  
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Link Delays IC 

 

Note: The default Modem Interleaver Mode setting is on for channel sizes of 250 kHz and greater and off 

for channel sizes of 200 kHz and less (see ‘Modem Interleaver Mode’ on page 72). 

 

Interleaver off

Channel size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA 49.6 ms 39.4 ms 34.9 ms NA

75 kHz 35.5 ms 19.0 ms 16.8 ms 13.6 ms 10.6 ms

100 kHz 28.8 ms 15.3 ms 12.7 ms 10.9 ms 8.2 ms

150 kHz 17.5 ms 10.1 ms 8.5 ms 7.1 ms 5.7 ms

200 kHz 15.9 ms 8.8 ms 7.3 ms 6.4 ms 5.1 ms

500 kHz 6.3 ms 3.5 ms 3.4 ms 3.2 ms 2.8 ms

1.0 MHz 3.8 ms 2.6 ms 2.3 ms 2.2 ms 2.1 ms

1.75 MHz 3.1 ms 2.3 ms 2.1 ms 2.0 ms 1.9 ms

3.5 MHz 2.6 ms 2.0 ms 1.8 ms 1.8 ms 1.7 ms

7.0 MHz 2.0 ms 1.7 ms 1.6 ms 1.6 ms 1.6 ms

14 MHz NA 1.6 ms 1.5 ms 1.5 ms 1.5 ms

Interleaver on

Channel size QPSK 16 QAM 32 QAM 64 QAM 128 QAM

25 kHz NA 164.7 ms 127.7 ms 111.8 ms NA

75 kHz 103.7 ms 53.2 ms 45.8 ms 36.4 ms 28.8 ms

100 kHz 85.3 ms 43.6 ms 35.3 ms 29.7 ms 21.4 ms

150 kHz 51.4 ms 26.8 ms 21.9 ms 18.6 ms 14.3 ms

200 kHz 45.8 ms 23.7 ms 19.3 ms 16.4 ms 12.3 ms

500 kHz 16.5 ms 9.3 ms 8.0 ms 6.9 ms 5.7 ms

1.0 MHz 8.8 ms 5.1 ms 4.3 ms 3.9 ms 3.5 ms

1.75 MHz 6.8 ms 4.1 ms 3.6 ms 3.2 ms 2.9 ms

3.5 MHz 5.1 ms 3.2 ms 2.8 ms 2.6 ms 2.4 ms

7.0 MHz 3.5 ms 2.4 ms 2.2 ms 2.1 ms 2.0 ms

14 MHz NA 2.1 ms 1.9 ms 1.8 ms 1.8 ms

Notes The end to end link delays are measured from E1 / T1 interface to E1 / T1 interface 

The delay figures are typical and can vary when the system re-synchronizes

NA (Not Available)  
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Receiver Performance 
 

-20 dBm

58 to 87 dB (at 10
-6

 BER)

depending on modulation type and channel size 

C/I ratio =  CdB - IdB

Co-channel better than 16 dB at QPSK

better than 20 dB at 16 QAM

better than 23 dB at 32 QAM

better than 27 dB at 64 QAM

better than 30 dB at 128 QAM

1st adjacent channel better than -5 dB

2nd adjacent channel better than -30 dB

Notes Typical performance specified at the antenna port for 10
-6

 BER.

The dynamic range is typically 2 dB greater for a BER of 10
-3

.

Maximum input level

Dynamic range

C/I ratio

(carrier to interference ratio)

 

Duplexers 
 

Code
Frequency

Band
Option

TX / RX

Min Split
Passband Lo Band Hi Band Mounting

A0 300 MHz Standard 9.45 MHz 2 MHz 330 - 400 MHz 330 - 400 MHz External

A1 300 MHz Option 1 5 MHz 0.5 MHz 330 - 400 MHz 330 - 400 MHz External

A2 300 MHz Option 2 20 MHz 3.5 MHz 330 - 400 MHz 330 - 400 MHz External

B0 400 MHz Standard 9.45 MHz 2 MHz 400 - 470 MHz 400 - 470 MHz External

B1 400 MHz Option 1 5 MHz 0.5 MHz 400 - 470 MHz 400 - 470 MHz External

B2 400 MHz Option 2 20 MHz 3.5 MHz 400 - 470 MHz 400 - 470 MHz External

C0 400 MHz Standard 3 MHz 0.5 MHz 470 - 492 MHz 473 - 495 MHz External

D0 600 MHz Standard 45 MHz 7 MHz 620 - 715 MHz 620 - 715 MHz Internal

E0 700 MHz Standard 30 MHz 7 MHz 698 - 806 MHz 698 - 806 MHz Internal

F0 800 MHz Standard 40 MHz 7 MHz 805 - 890 MHz 805 - 890 MHz Internal

G0 900 MHz Standard 40 MHz 7 MHz 850 - 960 MHz 850 - 960 MHz Internal

G1 900 MHz Option 1 9 MHz 1.5 MHz 928 - 960 MHz 928 - 960 MHz External

G2 900 MHz Option 2 9 MHz 1 MHz 928 - 960 MHz 928 - 960 MHz Internal

G3 900 MHz Option 3 5.5 MHz 0.5 MHz 900 - 960 MHz 900 - 960 MHz External

G4 900 MHz Option 4 3.6 MHz 0.5 MHz 900 - 960 MHz 900 - 960 MHz External

H0 1400 MHz Standard 48 MHz 7 MHz 1350 - 1550 MHz 1350 - 1550 MHz Internal

H1 1400 MHz Option 1 23.5 MHz 7 MHz 1350 - 1550 MHz 1350 - 1550 MHz Internal

K0 1800 MHz Standard 47.5 MHz 14 MHz 1700 - 2100 MHz 1700 - 2100 MHz Internal

I0 2000 MHz Standard 91 MHz 14 MHz 1900 - 2300 MHz 1900 - 2300 MHz Internal

J0 2500 MHz Standard 74 MHz 14 MHz 2300 - 2700 MHz 2300 - 2700 MHz Internal

J1 2500 MHz Option 1 32 MHz 4 MHz 2314 - 2318 MHz 2346 - 2350 MHz Internal

Notes All duplexers are bandpass

Contact 4RF for other duplexer options  



302  |  Specifications 

 
 

Aprisa XE User Manual 

 

Interface Specifications 
 

Ethernet Interface 

General Interface RJ-45 * 4 (Integrated 4-port switch) 

 Cabling CAT-5 UTP, supports auto MDIX (Standard Ethernet) 

 Maximum line length 100 metres on cat-5 or better 

 Bandwidth allocation n x 8 kbit/s up to maximum available.  
n x 64 kbit/s is recommended for terminals with higher 
channel size (> 500 kHz, 32 QAM). 

 Ethernet capacity The ethernet capacity maximum is determined by the lesser 
of the available radio link capacity or 50 Mbit/s. 

 Maximum packet size ‘Standard’ Ethernet packets: max 1518 octets 
Tagged and double-tagged packets: max 1526 octets 

 Data buffer size Up to 256 frames 

 Address table size 2048 IP addresses 

 WAN protocol HDLC 

 Ethernet mode 10Base-T or 100Base-TX  
Full duplex or half duplex  
(Auto-negotiating and auto-sensing) 

 VLAN tagging IEEE 802.1Q VLAN tagging 

 QoS IEEE 802.1p 
Ipv4 TOS DiffServ 
Ipv6 traffic class 

 Spanning Tree Forwards 802.1D Spanning Tree Protocol packets up to 1526 
bytes in length. 

Diagnostics Green LED On: Ethernet signal received 
Flashing: Indicates data traffic present on the interface 

 

 

Note: Do not connect Power over Ethernet (PoE) connections to the Aprisa XE Ethernet ports as this will 

damage the port. 
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QJET Quad E1 / T1 Interface 

General Standard G.703 and G.704 

 Interface RJ-45 

 Line termination impedance E1  120 Ω balanced 

T1  100 Ω balanced 

 Maximum line length E1 typically up to 1.7 km (43 dB of loss at 1024 kHz in 
standard 0.4 mm2 cable). 

T1 typically up to 1.7 km (36 dB of loss at 772 kHz in 
standard 0.4 mm2 cable). 

 Bandwidth allocation Framed E1s require a link bandwidth of 2048 kbit/s. 

Unframed E1s require a link bandwidth of 2088 kbit/s. 

Framed T1s require a link bandwidth of 1544 kbit/s. 

Unframed T1s require a link bandwidth of 1584 kbit/s. 

 Line code E1  HDB3 or AMI 

T1  B8ZS or AMI 

 Tx Waveform Shaper 
(T1 only) 

0 ~ 133 ft 
133 ~ 266 ft 
266 ~ 399 ft 
399 ~ 533 ft 
533 ~ 655 ft 

 Stability ±50 ppm 

 Jitter performance G.823 (sections 2 & 3) 

Diagnostics Green LED On: Interface is operational and in service 
Off: No 2 Mbit/s input signal 
Flashing: The interface loopback is active. 

 Yellow LED On: Alarm 
Off: No alarm 
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Q4EM Quad 4 Wire E&M Interface 

General Audio 64 kbit/s (PCM A-Law as per ITU G.711)  
32, 24 and 16 kbit/s (ADPCM as per ITU G.726 and ANSI 
TI.303) 

 E&M signalling 8 kbit/s per port 

 Maximum line length 400 metres 

Analogue Transmission performance 
characteristics 

ITU G.712 E4 for an operating level range of -14 dBr to 
+4 dBr for a G.711 64 kbit/s coded channel 

 Input level range -14.0 dBr to +4.0 dBr in 0.5 dB steps 

 Output level range -14.0 dBr to +4.0 dBr in 0.5 dB steps 

 Default output level 0 dBr 

 Default input level 0 dBr 

 Maximum level +3.14 dBm0 

 Port impedance 600 Ω 

 Return loss better than 25 dB over the frequency range 200 - 3600 Hz  

 Transformer isolation 3.88 kV 

 End to end gain 
Frequency response 

0 dB ± 0.1 dB (300-3000 Hz) 
0 dB ± 0.5 dB (250-3400 Hz) 

 Audio line protection Secondary protection 

 Signal to total distortion > 30 dB (0 dBm0 to -30 dBm0) 
> 22 dB (-45 dBm0) 

 

Signalling E&M Mode independent (external power supply / ground 
reference required) 

 Pulse distortion 4:1 multiplexed < 2.250 ms 

Non-multiplexed  250 µs 

 M loop current 5.0 to 6.5 mA (constant current) 

 M detection voltage 9 VDC 

 M maximum voltage 60 VDC 

 E circuit impedance 45 Ω closed 
> 100 kΩ open 

 Maximum E circuit current 100 mA 

 E maximum voltage 60 V 

 E&M circuit protection E: Current limited to 120 mA, overvoltage to 350 V 
M: Current limited to 6.5 mA, overvoltage to 100 V 

Diagnostics Green LED Off: No external source applied to M wire 
On: External source applied to M wire 
Flashing: The interface loopback is active 

 Yellow LED Off: E wire relay contact open 
On: E wire relay contact closed 
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DFXO Dual Foreign Exchange Office Interface 

General Audio 64 kbit/s (PCM as per ITU G.711)  
32, 24 and 16 kbit/s (ADPCM as per ITU G.726 and ANSI 
TI.303) 

 Signalling allocation 8 or 32 kbit/s allocated for CAS (multiplexed / non 
multiplexed) 

 Companding A-Law or µ-Law 

 Maximum line length 600 metres (2000 feet) on 0.4 mm / 26 AWG copper pair 

 Calling line ID (CLI) Support provided for ETSI: EN 300 659-1 & 2 and BT: SIN 227 
and 242 

 Fax Conforms to G3 standard for 64 kbit/s PCM and 32 kbit/s 
ADPCM compression 

Analogue Transmission performance 
characteristics 

ITU G.712 E2 for an operating level range of -6 dBr to +1 dBr 
for a G.711 64 kbit/s coded channel 

 Input level range -10 dBr to +1.0 dBr in 0.5 dB steps 

 Output level range -10 dBr to +1.0 dBr in 0.5 dB steps 

 Default Input level -4.0 dBr 

 Default Output level -1.0 dBr 

 Maximum level +3.14 dBm0 

 Line impedance / Hybrid 
balance impedance options 

600 Ω 
900 Ω 
600 Ω + 2.16 µF 
900 Ω + 2.16 µF 
270 Ω + 750 Ω || 150 nF (TBR-21) 
220 Ω + 820 Ω || 120 nF (TN12) 
370 Ω + 620 Ω || 310 nF (BT3) 
320 Ω + 1050 Ω || 210 nF (BT Network) 
200 Ω + 680 Ω || 100 nF (China) 

 Return Loss better than 12 dB 300 Hz to 600 Hz 

better than 15 dB 600 Hz to 3400 Hz  

 Trans hybrid loss better than 13 dB 300 Hz to 3400 Hz 

better than 17 dB 500 Hz to 2500 Hz 

(with matched external line and hybrid balance impedance) 

 Common mode rejection 
ratio 

better than 40 dB 50 Hz to 3800 Hz 

better than 46 dB 600 Hz to 3400 Hz 

 Echo Canceller provides up to 64 ms of echo cancellation 

reduces the echo by more than 15 dB at an input signal level 

of 10 dBm0. 
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Signalling DTMF dialing Standard DTMF dialing over the voice channel 

 Pulse dialing Transparent decadic signalling at 7 - 14 PPS with break 
period limits of 60 - 73 % 

 Pulse distortion 4:1 multiplexed < 2.250 ms 

Non-multiplexed  250 µs 

 Reversals Line polarity reversal detection 

 Loop current limit maximum of 60 mA with Loop Current Limiter On 

maximum of 160 mA with Loop Current Limiter Off 

 Metering level sensitivity 12 kHz / 16 kHz billing tone detection with a selectable 
level sensitivity of -17dBm to -40 dBm in 1dB steps into 200 
Ω 

(60 mV rms to 5 mV rms into 200 Ω). 

 Metering level maximum The maximum level of metering signal the DFXO can tolerate 
without voice band interference is 0.8 Vrms into 200 Ω. 

 Loop resistance on-hook >1 MΩ 

 Ringing detection threshold Three selectable options of 16 Vrms, 26 Vrms and 49 Vrms ± 
20 %. 

 Ringing detection frequency 15 to 50 Hz sine wave 

 Ringing input impedance Two selectable options of >1 MΩ and >12 kΩ 

 Ringing DC offset range 
tolerance 

0 to -75VDC 

 Ringing input voltage 
maximum 

up to 100 Vrms 

 Ringing cadence limits   min  max 

Ringing ON: 270 ms  10 secs 

Ringing OFF: 180 ms  4 secs 

 Ringing cadence distortion < 40 ms cadence error on both ring and silent periods 

Physical Physical interface Dual RJ-45 per port (1 line port, 1 monitor port) 

Diagnostics Green LED Off: Interface operational but not in service 
On: Interface in service 
Flashing: Cadenced ringing on line 

 Yellow LED Off: No interface alarm 
On: Interface alarm 
Flashing: The interface loopback is active 
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DFXS Dual Foreign Exchange Subscriber Interface 

General Audio 64 kbit/s (PCM as per ITU G.711)  
32, 24 and 16 kbit/s (ADPCM as per ITU G.726 and ANSI 
TI.303) 

 Signalling Allocation 8 or 32 kbit/s allocated for CAS (multiplexed / non 
multiplexed) 

 Compression coding A-Law or µ-Law 

 Maximum line length 600 metres (2000 feet) on 0.4 mm / 26 AWG copper pair 

 Calling line ID (CLI) Support provided for ETSI: EN 300 659-1 & 2 and BT: SIN 227 
and 242 

 Fax Conforms to G3 standard for 64 kbit/s PCM and 32 kbit/s 
ADPCM compression 

Analogue Transmission performance 
characteristics 

ITU G.712 E2 for an operating level range of -6 dBr to 
+2.0 dBr for a G.711 64 kbit/s coded channel 

 Input level range -9.0 dBr to +2.0 dBr in 0.5 dB steps 

 Output level range -9.5 dBr to +2.5 dBr in 0.5 dB steps 

 Default Input level +1.0 dBr 

 Default Output level -6.0 dBr 

 Maximum level +3.14 dBm0 

 Line impedance / Hybrid 
balance impedance options 

600 Ω 
900 Ω 
600 Ω + 2.16 µF 
900 Ω + 2.16 µF 
220 Ω + (820 Ω || 120 nF) (TN12) 
270 Ω + (750 Ω || 150 nF) (TBR21) 
370 Ω + (620 Ω || 310 nF) (BT3) 

 Return Loss better than 12 dB 300 Hz to 600 Hz 

better than 15 dB 600 Hz to 3400 Hz 

 Trans hybrid loss better than 13 dB 300 Hz to 3400 Hz 

better than 17 dB 500 Hz to 2500 Hz 

(with matched external line and hybrid balance impedance) 

 Common mode rejection 
ratio 

better than 40 dB 50 Hz to 3800 Hz 

better than 46 dB 600 Hz to 3400 Hz 
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Signalling Feed voltage output -48 V (160 + 160 Ω voltage source current limited) 

 Loop current limit 35 mA ± 10 %. 

 Seize signal Loop start only (no ground start) 

 Loop detect threshold 9 to 12 mA (step function between on hook and off hook) 

 Loop non-seizure current > 6 mA (step function between on hook and off hook) 

 Loop release threshold > 4 mA 

 DTMF dialing Standard DTMF dialing over the voice channel 

 Pulse dialing Transparent decadic signalling at 7 - 14 PPS with break 
period limits of 60 - 73 % (with loop current > 23 mA) 

 Pulse distortion 4:1 multiplexed < 2.250 ms 

Non-multiplexed  250 µs 

 Reversals output Line polarity reversal output (optional) 

 Metering output frequency 12 kHz / 16 kHz ± 0.5 %.  

 Metering output voltage Four selectable output voltages of 100 mV, 200 mV, 300 mV 
and 400 mV rms into 200 Ω ± 20 % sourced via the Line 
Impedance setting but limited to a maximum open circuit 
voltage of 1 Vrms.  

 Metering output distortion Billing tone total distortion < 5 %. 

 Ringer waveform Sinusoidal with a maximum total distortion of 10% (into 3 
REN load) 

 Ringer voltage (open circuit) Five selectable ringer output voltages sourced via an 

internal ringing resistance of 178 per port. 

The ringing output is a composite balanced AC ringing 
voltage with a differential DC offset voltage. 

60 Vrms + 0 VDC 

55 Vrms + 10 VDC 

50 Vrms + 18 VDC 

45 Vrms + 22 VDC 

40 Vrms + 24 VDC 

Both the DC and AC components have a tolerance of ± 5%. 

 Ringer output frequency Three selectable options of 17, 25 or 50 Hz ± 5% 

 Ringer output power 60 Vrms source into a load of 2 REN 
45 Vrms source into a load of 3 REN 

(1 REN  6930 F) 

 Ring trip Ring trip will ocurr in < 150 ms following DC loop of > 20 mA 

 Ring trip immunity Ring trip will not ocurr if the DFXS outputs ringing into a 

load of 500  in series with 4.4 F or less. 

Physical Physical interface Dual RJ-45 per port (1 line port, 1 monitor port) 

 Line protection Secondary protection (4RF recommends the use of external 
primary protection in lightning prone areas) 

Diagnostics Green LED Off: Interface operational but not in service 
On: Interface in service 
Flashing: Cadenced ringing on line 

 Yellow LED Off: No interface alarm 
On: Interface alarm 
Flashing: The interface loopback is active 
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QV24 Quad V.24 Serial Data Interface 

General Interface ITU-T V.24 / EIA/TIA RS-232E 

 Interface direction DCE only 

 Bandwidth allocation 8 to 120 kbit/s in 8 kbit/s steps (dependent on rate 
selected) 

 Control line allocation 8 kbit/s 

 Maximum line length 10 metres 

 Data clamp Mark hold when out of sync. 

 Control line clamp Off when loss of sync. 

 Clock Internally generated from 2.048 MHz system clock 
(synchronized at both ends) 

Async 
parameters 

Transparent mode Operation is completely transparent but limited to 0-600 
bit/s 

 Standard mode data bits 7 or 8 bits 

 Standard mode parity Transparent  (enable / disable) 

 Standard mode stop bits 1 or 2 bits 

 Asynchronous Data rates 300, 600, 1200, 2400, 4800, 7200, 9600, 12800, 14400, 
19200, 23040, 28800, 38400, 57600 and 115200 bit/s 

Control signals End-to-end CTS to RTS, DSR to DTR 

Diagnostics Green LED Indicates RX data traffic present 

 Yellow LED Indicates TX data traffic present 

 

QV24S Quad V.24 Serial Data Interface 

General Interface ITU-T V.24 / EIA/TIA RS-232E 

 Interface direction DCE only 

 Bandwidth allocation 8 to 120 kbit/s in 8 kbit/s steps (dependent on rate 
selected) 

 Control line allocation 8 kbit/s 

 Maximum line length 10 metres 

 Data clamp Mark hold when out of sync. 

 Control line clamp Off when loss of sync. 

 Synchronous Data rates 300, 600, 1200, 2400, 4800, 9600 and 19200 bit/s 

Control signals End-to-end CTS to RTS 

Diagnostics Green LED Indicates RX data traffic present 

 Yellow LED Indicates TX data traffic present 
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HSS Single High Speed Synchronous Data Interface 
 
 

General Interfaces ITU-T V.35 

ITU-T X.21 

EIA RS-449 

EIA RS-530 

 Bandwidth allocation 8 to 2048 kbit/s in 8 kbit/s steps (dependent on rate 
selected) 
8 kbit/s for control lines 

 Maximum line length 3 metres 

 Clock Internally generated from 2.048 MHz system clock 
(synchronized at both ends) on DCE to DCE mode. 

Clock provided by external DCE when in DTE mode. 

Remote DCE outputs clock-timed by incoming clock at DTE. 

Diagnostics Top Green LED On: Normal operation 
Flashing: Loopback 

 Lower Green LED On: Normal operation 

 

 

External Alarm Interfaces 

Alarm inputs Detector type Isolated current detectors 

 Detection current 5.0 to 6.5 mA (constant current) 

 Detection voltage 9 to 60 VDC or AC rms 

Alarm outputs Contact type Isolated semiconductor relay type contacts 

 Maximum current 100 mA 

 Maximum voltage 0 to 60 VDC or AC rms 

 Ouput impedance 45 Ω closed 
> 100 kΩ open 

Overall Latency The latency for an alarm presented on an external alarm 
input to the alarm being output on an external alarm output 
is < 2 seconds 

 

Auxiliary Interfaces 

Management Configuration and 
management 

Embedded web server and / or SNMP accessed via Ethernet 
interface or across link 

Test points RSSI Front panel test point for measuring the RSSI voltage 
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Power Specifications 
 

AC Power Supply 

Nominal 

voltage 

Input voltage 
range 

Maximum Power 
input 

Max VA Frequency 

115 VAC 103 - 127 Vrms 180 W 400 VA 47 - 63 Hz 

230 VAC 207 - 254 Vrms 180 W 400 VA 47 - 63 Hz 

 

DC Power Supply 

Nominal voltage Input voltage 
range 

Maximum Power 
input 

Maximum input 
current 

Recommended 
DC breaker 

rating 

+12 VDC LP 10.5 to 18 VDC 53 W 5 A 8 A 

±12 VDC 10.5 to 18 VDC 180 W 18 A 25 A 

±24 VDC 20.5 to 30 VDC 180 W 8 A 10 A 

±48 VDC 40 to 60 VDC 180 W 4 A 5 A 
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Power Consumption 
 

Terminal Type Power Consumption (min – max) 

Standard Aprisa XE 1+0 terminal 34 to 170 W Input power 

(dependent on the transmitter output power, the interface cards 
fitted and the power supply option) 

Standard Aprisa XE 1+1 terminal 74 to 375 W Input power 

(dependent on the transmitter output power, the interface cards 
fitted, the number of trib switches and the power supply option) 

Standard Aprisa XE HSD terminal 68 to 286 W Input power 

(dependent on the transmitter output power, the interface cards 
fitted and the power supply option) 

 

Power Consumption Model 

An Aprisa XE Power Consumption model program called XEpower is on the Aprisa XE CD. This program 

shows the typical power consumption for any product configuration. Java 1.6 is required to be installed on 

your PC to run this program. 

 

Standard Aprisa XE 1+0 terminal – 48 VDC 

These power consumption figures represent the typical power drawn by a single standard 1400 MHz 1+0 

terminal measured at the input to a ± 48 VDC power supply. 

 

Power Consumption (min – max) 40 to 150 W Input power (dependent on interface cards fitted 
and transmitter output power level) 

Terminal only: 

 TX power of + 20 dBm 44 W 

 TX power of + 25 dBm 54 W 

 TX power of + 30 dBm 61 W 

 TX power of + 35 dBm 64 W 

Interface cards: 

 QJET four port E1 card 2.3 W (four ports operating) 

 Q4EM four port 4W E&M card 0.6 W (all states) 

 QV24 four port V.24 card 0.2 W (all states) 

 DFXO two port 2W FXO card 0.7 W (all states) 

 DFXS two port 2W FXS card One DFXS card installed with both ports idle (on hook): 2.5 W 

Plus: 

1.9 W / line off-hook (200 ohm copper loop plus 450 ohm 
telephone)   

1.0 W / line ringing (60 Vrms 25Hz source via 100 ohm copper 
loop into a 1 REN load)  

1.5 W / line ringing (45 Vrms 25Hz source via 100 ohm copper 
loop into a 3 REN load) 

 HSS single port high speed data 1.0 W (all states) 

MHSB: 

Tributary and RF switch 13 W not switched 

 25 W switched 
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Low Power Aprisa XE 1+0 terminal – 12 VDC 

These power consumption figures represent the typical power drawn by a single low power 1400 MHz 1+0 

terminal measured at the input to a low power +12 VDC power supply. 

 

Power Consumption (min – max) 34 to 53 W Input power (dependent on interface cards fitted and 
transmitter output power level) 

Terminal only: 

 TX power of + 20 dBm 34 W 

 TX power of + 24 dBm 40 W 

Interface cards: 

 QJET four port E1 card 1.9 W (four ports operating) 

 Q4EM four port 4W E&M card 0.53 W (all states) 

 QV24 four port V.24 card 0.15 W (all states) 

 DFXO two port 2W FXO card 0.56 W (all states) 

 DFXS two port 2W FXS card One DFXS card installed with both ports idle (on hook): 2.1 W 

Plus: 

1.6 W / line off-hook (200 ohm copper loop plus 450 ohm 
telephone)   

0.8 W / line ringing (60 Vrms 25Hz source via 100 ohm copper 
loop into a 1 REN load)  

1.2 W / line ringing (45 Vrms 25Hz source via 100 ohm copper 
loop into a 3 REN load) 

 HSS single port high speed data 0.85 W (all states) 
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Protection System Specifications 
 

MHSB Protection 

MHSB switches Switching time < 25 ms from detection of alarm condition 

 Switch hysteresis 30 seconds (to prevent switching on short alarm transients) 

 RF path restore time < 10 seconds 

RF switch TX relay / cable loss  1.0 dB 

 RX splitter / cable loss  4.0 dB 

 Total system loss System gain reduced by a maximum of 5 dB 

Tributary switch Ports 8 

 
 

HSD Protection 

TX path TX relay / cable loss  1.0 dB 

Switching times Transmit path < 25 ms from detection of alarm condition 

 Receive path Hitless 
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General Specifications 

Environmental 
 

Operating range -10 to +50˚ C 

Storage range -20 to +70˚ C 

Humidity Maximum 95% non-condensing 

Acoustic noise emission 59 dBA (A-weighted Sound Power Level) 

 

Mechanical 
 

Height Standard terminal 

2 U high (internal duplexer)  
3 – 4 U high (depending on external duplexer type) 
 

MHSB terminal 

6 U high (internal duplexer)  
7 – 8 U high (depending on external duplexer type) 
 

HSD terminal 

4 U high (internal duplexer)  
6 – 8 U high (depending on external duplexer type) 

Width 19-inch rack mount 

434 mm (without mounting brackets attached) 

483 mm (with mounting brackets attached) 

Depth 372 mm  

Colour Pure black 

Weight Standard terminal 

8 kg (internal duplexer)  
9 - 12 kg (depending on external duplexer type) 
 

MHSB terminal 

25 kg (internal duplexer)  
26 – 29 kg (depending on external duplexer type) 
 

HSD terminal 

17 kg (internal duplexer)  
19 – 24 kg (depending on external duplexer type) 

 

ETSI Compliance 
 

Radio EN 301 751, EN 300 630 
EN 302 217 Parts 1, 2.1, and 2.2 

EMI/EMC EN 301 489 Parts 1 & 4 

Safety EN 60950 

CSA 253147 applicable for AC, 48 VDC and 24 VDC product 
variants 

Environmental ETS 300 019 Class 3.2 
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19. Product End Of Life 

End-of-Life Recycling Programme (WEEE) 

The WEEE Directive concerns the recovery, reuse, and recycling of electronic and electrical equipment. 

Under the Directive, used equipment must be marked, collected separately, and disposed of properly. 

4RF Limited has implemented an end-of-life recycling programme to manage the reuse, recycling, and 

recovery of waste in an environmentally safe manner using processes that comply with the WEEE Directive 

(EU Waste Electrical and Electronic Equipment 2002/96/EC). 

 

The WEEE Symbol Explained 

 

This symbol appears on Electrical and Electronic Equipment (EEE) as part of the WEEE (Waste EEE) 

directive. It means that the EEE may contain hazardous substances and must not be thrown away with 

municipal or other waste. 

 

WEEE Must Be Collected Separately 

You must not dispose of electrical and electronic waste with municipal and other waste. You must 

separate it from other waste and recycling so that it can be easily collected by the proper regional WEEE 

collection system in your area. 

 

YOUR ROLE in the Recovery of WEEE 

By separately collecting and properly disposing of WEEE, you are helping to reduce the amount of WEEE 

that enters the waste stream. 

One of the aims of the WEEE directive is to divert EEE away from landfill and encourage recycling. 

Recycling EEE means that valuable resources such as metals and other materials (which require energy to 

source and manufacture) are not wasted. Also, the pollution associated with accessing new materials and 

manufacturing new products is reduced. 

 

EEE Waste Impacts the Environment and Health 

Electrical and electronic equipment (EEE) contains hazardous substances which have potential effects on 

the environment and human health. If you want environmental information on the Aprisa XE terminal, 

contact us (on page 19).  
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20. Abbreviations 

ADC Analogue to Digital Converter 

ADPCM Adaptive Differential Pulse Code 

Modulation 

ADSL Asymmetrical Digital Subscriber 

Line 

AGC Automatic Gain Control 

AMP Amplifier 

BER Bit Error Rate 

CAS Channel Associated Signalling 

CPE Customer Premises Equipment 

CLI Calling Line Identification 

DAC Digital to Analogue Converter 

dB Decibels 

dBc Decibels relative to carrier power 

dBm Decibels relative to 1 mW 

dBr Decibels relative to the 

transmission reference point 

DCE Data Communications Equipment 

DTE Data Terminal Equipment 

DTI Digital Trunk Interface 

E&M Ear and Mouth 

EMC Electro-Magnetic Compatibility 

EMI Electro-Magnetic Interference 

ESD Electro-Static Discharge 

ETSI European Telecommunications 

Standards Institute 

FAS Frame Alignment Signal (E1 

frame) 

FEC Forward Error Correction 

FFE Feed Forward Equalizer 

F/W Firmware 

FXO Foreign Exchange Office 

FXS Foreign Exchange Subscriber 

GSM Global System for Mobile 

communications 

HSC Hardware Software Compatibility 

HSS High-Speed Synchronous Serial 

H/W Hardware 

IC Integrated Circuit 

IF Intermediate Frequency 

IP Internet Protocol 

I/O Input/Output 

ISP Internet Service Provider 

kbit/s Kilobits per second 

kHz Kilohertz 

LAN Local Area Network 

LED Light Emitting Diode 

LOS Loss of Signal 

mA Milliamps 

MAC Media Access Control 

Mbit/s Megabits per second 

MHSB Monitored Hot Standby 

MHz Megahertz 

MIB Management Information Base 

MTBF Mean Time Between Failures 

MTTR Mean Time To Repair 

ms milliseconds 

NFAS Not Frame Alignment Signal (E1 

frame) 

NMS Network Management System 

OSI Open Systems Interconnection 

PABX Private Automatic Branch 

Exchange 

PBX Private Branch Exchange 

PC Personal Computer 

PCM Pulse Code Modulation 

PCA Printed Circuit Assembly 

PLL Phase Locked Loop 

POP Point of Presence 

POTS Plain Old Telephone Service 

ppm Parts Per Million 

PSTN Public Switched Telephone 

Network 

PMR Public Mobile Radio 



 

 

QAM Quadrature Amplitude Modulation 

QPSK Quadrature Phase Shift Keying 

RAI Remote Alarm Indicator 

RF Radio Frequency 

RoHS Restriction of Hazardous 

Substances 

RSSI Received Signal Strength 

Indication 

RX Receiver 

SNMP Simple Network Management 

Protocol 

SNR Signal to Noise Ratio 

SWR Standing Wave Ratio 

TCP/IP Transmission Control 

Protocol/Internet Protocol 

TCXO Temperature Compensated 

Crystal Oscillator 

TETRA Terrestrial Trunk Radio 

TFTP Trivial File Transfer Protocol 

TMR Trunk Mobile Radio 

TX Transmitter 

UTP Unshielded Twisted Pair 

VAC Volts AC 

VCO Voltage Controlled Oscillator 

VDC Volts DC 

VoIP Voice over Internet Protocol 

WEEE Waste Electrical and Electronic 

Equipment 
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21. Acknowledgments and Licensing 

The Aprisa XE product software runs the GNU Linux Operating System and incorporates several other 

packages in accordance with the free software philosophy. 

The following list identifies the licensed software used: 

BusyBox 

Description: Tiny versions of common UNIX utilities 

Reference: http://busybox.net/ 

License Type: GNU General Public License (GPL) 

DropBear SSH Server 

Description: Small and secure SSH Server 

Reference: http://matt.ucc.asn.au/dropbear/ 

License Type: MIT Style License 

GoAhead WebServer 2.1 

Description: Embedded Web Server 

Reference: http://webserver.goahead.com/ 

License Type: Private License 

Linux Kernel 

Description: Linux Kernel version 2.4.26 

Reference:  http://www.kernel.org/ 

License Type: GNU General Public License (GPL) 

Net-SNMP 

Description: Various tools relating to SNMP 

Reference: http://www.net-snmp.org/ 

License Type: CMU/UCD and BSD License 

uClibc 

Description: C library for embedded Linux systems 

Reference: http://uclibc.org/ 

License Type: GNU Lesser General Public License (LGPL) 

U-Boot 

Description: Bootloader 

Reference: http://u-boot.sourceforge.net/ 

License Type: GNU General Public License (GPL) 

http://busybox.net/
http://matt.ucc.asn.au/dropbear/
http://webserver.goahead.com/
http://www.kernel.org/
http://www.net-snmp.org/
http://uclibc.org/
http://u-boot.sourceforge.net/
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Software Licensed Under the GPL 

Some of the above packages licensed under the GPL have been modified by 4RF Limited. The copyright 

holders of these modified packages (including 4RF Limited) agree to them being distributed under the 

terms of the General Public License. 

Copies of the GNU General Public License (GPL) and Lesser General Public License (LGPL) can be obtained 

from the Free Software Foundation Inc, 59 Temple Place - Suite 330, Boston, MA, 02111-1307, USA.  Plain 

text copies of these licenses can also be found at: 

http://www.gnu.org/licenses/gpl.txt 

http://www.gnu.org/licenses/lgpl.txt 

If you would like a copy of the GPL source code used in this product on a CD, please send US$50.00 (to 

cover the preparation of the CD and transport costs) to 4RF Limited, PO Box 13-506, Wellington, New 

Zealand. 

Software Licensed Under Other Licenses 

The following copyright notices are included for packages not covered by the GPL: 

Dropbear SSH Server (MIT License) 

Dropbear—a SSH2 server 

Copyright © 2002, 2003 Matt Johnston 

All rights reserved 

Permission is hereby granted, free of charge, to any person obtaining a copy of this software and 

associated documentation files (the ‘Software’), to deal in the Software without restriction, including 

without limitation the rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell 

copies of the Software, and to permit persons to whom the Software is furnished to do so, subject to the 

following conditions: 

The above copyright notice and this permission notice shall be included in all copies or substantial 

portions of the Software. 

THE SOFTWARE IS PROVIDED ‘AS IS’, WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING 

BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 

NONINFRINGEMENT. IN NO EVENT SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR ANY CLAIM, 

DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING 

FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE 

SOFTWARE. 

http://www.gnu.org/licenses/gpl.txt
http://www.gnu.org/licenses/lgpl.txt
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Net-SNMP 

Part 1: CMU/UCD (BSD like) 

Copyright © 2001-2003, Networks Associates Technology, Inc 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 

that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution. 

Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be 

used to endorse or promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ‘AS IS'' AND ANY EXPRESS 

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE 

COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 

EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 

(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 

IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Part 2: Networks Associates Technology, Inc. (BSD) 

Copyright © 2001-2003, Networks Associates Technology, Inc 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 

that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution. 

Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be 

used to endorse or promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ‘AS IS'' AND ANY EXPRESS 

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE 

COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 

EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 

(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 

IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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Part 3: Cambridge Broadband Ltd (BSD) 

Portions of this code are copyright © 2001-2003, Cambridge Broadband Ltd. 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 

that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution. 

The name of Cambridge Broadband Ltd. may not be used to endorse or promote products derived from this 

software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDER ‘AS IS'' AND ANY EXPRESS OR IMPLIED 

WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND 

FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE COPYRIGHT HOLDER BE 

LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES 

(INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, 

DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, 

WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN 

ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

Part 4: Sun Microsystems, Inc. (BSD) 

Copyright © 2003 Sun Microsystems, Inc., 4150 Network Circle, Santa Clara, 

California  95054, U.S.A. All rights reserved. 

Use is subject to license terms below. 

This distribution may include materials developed by third parties. 

Sun, Sun Microsystems, the Sun logo and Solaris are trademarks or registered trademarks of Sun 

Microsystems, Inc. in the U.S. and other countries. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 

that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution. 

Neither the name of the Sun Microsystems, Inc. nor the names of its contributors may be used to endorse 

or promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ‘AS IS'' AND ANY EXPRESS 

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE 

COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 

EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 

(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 

IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 
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Part 5: Sparta, Inc. (BSD) 

Copyright © 2003-2004, Sparta, Inc 

All rights reserved. 

Redistribution and use in source and binary forms, with or without modification, are permitted provided 

that the following conditions are met: 

Redistributions of source code must retain the above copyright notice, this list of conditions and the 

following disclaimer. 

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the 

following disclaimer in the documentation and/or other materials provided with the distribution. 

Neither the name of the Networks Associates Technology, Inc nor the names of its contributors may be 

used to endorse or promote products derived from this software without specific prior written permission. 

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS ‘AS IS'' AND ANY EXPRESS 

OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 

MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.  IN NO EVENT SHALL THE 

COPYRIGHT HOLDERS OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL, 

EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 

SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) 

HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 

(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN 

IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE. 

GoAhead WebServer (Private License) 

GoAhead WebServer 

Copyright (c) 2000 GoAhead Software, Inc. All Rights Reserved 
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22. Commissioning Form 

 





 

Index  |  329 

 

Aprisa XE User Manual 

 

23. Index 

2 

2 wire 105 

4 

4 wire 102 

A 

AC power supply 38 

access rights 63 

accessory kit 19 

AIS 250 

alarms 

alarm summary 242 

clearing alarms 247 

E1 / T1 alarm conditions 250 

external 33 

history 244 

identifying causes 248 

interface alarms 246 

saving history 245 

termination 33 

types 273 

A-law 110 

antennas 

aligning 197 

checking polarization 197 

corner reflector 23 

directional antennas 21, 22 

installing 32 

parabolic 21 

selection and siting 21 

siting 23 

yagi 22 

attenuators 41 

B 

balun transformer 256 

basic terminal settings 72 

bench setup 41 

BER 203 

brownout recovery module 39 

browser cache, clearing 222 

C 

cabling 

accessory kit 19 

coaxial feeder 24, 41 

for HSD 189 

for MHSB 183 

shielded 262 

cache, clearing 221, 222 

CAS 110, 159, 160, 161, 162 

Castle Rock 83 

CD contents 18 

clock source 

setting for 100, 131 

compatibility of interfaces 156 

configuration files 224 

configuration, saving 87, 153 

constellation analyser 205 

corner reflector antenna 23 

country specific settings 283 

cross connections 

creating 150 

deleting 155 

drop and insert 152 

point to point 150 

printing 154 

saving configurations 153 

selecting timeslots 164 

sending configurations 153 

Symmetrical Connection Wizard 174 

cross connections application 

about 145 

ethernet capacity 148 

getting configurations 149 

installing 144 

required system configuration for 143 

toolbar 147 

total assigned link capacity 145 

user capacity 148 

D 

DC power supply 35 

DCD mode 135 

declaration of conformity iii 

DFXO interface card 118 

country specific settings 283 

cross connections for 169 
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interface connections for 262 

port settings for 118 

signalling for 169 

DFXS interface card 110 

country specific settings 283 

cross connections for 169 

interface connections for 261 

port settings for 110 

signalling for 169 

directional antennas 21, 22 

Drop & Insert capacity 146 

DSR DTR mode 134 

duplexer parameters 77 

E 

E&M interface 102 

E1 

alarm conditions 250 

framed 158, 159 

unframed 158 

earthing 24, 26, 41 

environmental requirements 25 

error counters 203 

Ethernet 

capacity 148 

port status 98 

Quality of Service 94 

VLAN tagging 91 

exchange end 118 

external alarms 

configuring 79 

inputs 79 

mapping 81 

outputs 81 

F 

fade margin 202 

fault finding 201, 239, 251 

feeder cables 24 

framed mode 158 

framed modes 

PCM30C mode 159 

PCM31C mode 159 

T1 ESF modes 161, 162 

T1 SF modes 160 

frequency bands 27 

frequency bands ETSI 285 

front panel 

connections 29 

indicators 29 

tributary switch 180 

G 

gateway 

factory default 62 

H 

handshaking 

DCD mode 135 

DSR DTR mode 134 

RTS CTS mode 133 

hardware 

accessory kit 19 

installing 31, 32 

hitless 188 

HSD 188 

cabling 189 

configuring terminals 191 

IP addresses 190 

HSS clocking 

clocking types 137 

cloud mode 141 

internal clocking 137 

pass-through clocking 137 

pipe mode 138 

primary/secondary master clocking 137 

synchronous clock selection modes 136 

HSS interface card 131 

cross connections for 172 

handshaking 133 

interface connections for 263 

port settings for 131 

humidity 25 

I 

image files 226 

updating table of 230 

in-service commissioning 195 

installation 31, 33 

interface cabling 34 

interface cards 

before installing 234 

configuring 90 

installing 236 

port settings 90 

summary 89 

types 30 

interface connections 255 

DFXO 262 
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DFXS 261 

Ethernet 257 

HSS 263 

Q4EM 258 

QJET 256 

QV24 271 

QV24S 271 

interface pinouts 

HSS 263 

interface traffic direction 255 

interfaces, compatibility 156 

IP address 

factory defaults 62 

network 52 

terminal 73 

understanding 51 

J 

Java 

clearing cache 221 

requirement for 18, 47, 143 

L 

LEDs 

identifying colours 248 

interface 256, 257, 258, 261, 262, 263 

RF protection switch 182 

tributary protection switch 181 

lightning protection 26 

link budget 24 

link capacity, assigned 146 

link performance 201, 205 

LOF 250 

logging in 

SuperVisor 58 

Loop interface circuits 105 

loopbacks 

about 239 

interface lookbacks 240 

timeslot loopbacks 241 

LOS 250 

M 

maintenance 211 

major alarms, mapping 81 

management 

ethernet capacity 148 

MHSB 179 

cabling 183 

clearing alarms for 187 

configuring radios for 184 

configuring the terminals 186 

front panel 

RF protection switch ................... 181 

hot stand-by 179 

IP addressing 184 

monitored hot stand-by 179 

mounting 185 

power supply 183 

slave tributary switch 182 

standby mode 181 

tributary switch 

front panel ............................... 180 

MIB 

saving 87 

minor alarms, mapping 81 

modify user group 63 

mounting kit 19 

O 

operating temperature 25 

P 

passwords 

changing 65 

path planning 21 

path propagation calculator 21 

PCM modes 158, 159, 160, 161, 162 

performance, of link 201, 205, 206 

performance, save history 207 

pinouts 262 

DFXS 261 

Ethernet 257 

Q4EM 258 

QJET 256 

QV24 271 

QV24S 271 

Synchronous cable assemblies 264 

POTS 105, 110, 118 

power 

AC power 38 

DC cabling 36 

DC power 35 

power supply 25, 35 

powering up 196 

protected terminals 

HSD 188 

MHSB 179 
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Q 

Q4EM interface card 

cross connections for 168 

E&M signalling types 259 

interface connections for 258 

port settings for 102 

QJET interface card 

cross connections for 157 

interface connections for 256 

modes 158, 159, 160, 161, 162 

port settings for 100 

Quality of Service (QoS) 94 

QV24 interface card 126, 127 

baud rate 170 

cross connections for 170 

interface connections for 271 

port settings for 126, 127 

QV24S interface card 128 

interface connections for 271 

port settings for 128 

R 

rack space 31 

RAI 250 

rebooting the terminal 231 

receiver 28 

RF protection switch 

front panel 181 

LEDs 182 

RF settings 67 

modem performance 70 

RS-449 synchronous data 131 

RS-530 synchronous data 131 

RSSI 

alarm threshold 78 

aligning the antennas 199 

RTS CTS mode 133 

S 

safety earth 40 

setup menu 

COM port settings 44 

Hyperterminal 44 

setup basic settings 55 

signalling mode 169 

slots 

configuring 238 

terminal 30 

SNMP 83 

MIB details 86 

setting access controls 84 

setting trap destinations 85 

viewing traps 86 

Space Diversity 188 

specifications 285 

auxiliary interfaces 308 

DFXO interface 303 

DFXS interface 305 

environmental 313 

ethernet interface 300 

ETSI 313 

external alarms interface 308 

general 313 

HSS interface 308 

MHSB 312 

Q4EM interface 302 

QJET interface 301 

QV24 interface 307 

QV24s interface 307 

static damage, avoiding 236 

storage temperature 25 

subnet mask 

factory default 62 

subscriber end 110 

SuperVisor 57 

logging into 58 

logging out 59 

opening page 60 

PC requirements for 47 

PC settings for 48 

Surveyor 21 

syslog 251 

error logging 251 

remote logging 253 

system performance specifications 

ETSI 285 

T 

T1 

alarm conditions 250 

framed 158, 160, 161, 162 

unframed 158 

temperature 25 

terminal 

alarm summary 242 

applying power 196 

clocking 74 

earthing 26, 40, 41 

installing 31 

logging into 58 
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logging out 59 

modules 28 

near and far, explained 51 

operating conditions 25 

power supplies 35 

rebooting 231 

upgrading 224 

terminal emulator 87 

test equipment 204 

TFTP server 219 

timed reboot 231 

timeslots 

PCM modes 159 

selecting 164 

tools 31 

traffic direction of interfaces 255 

tranformer, Balun 256 

transmitter 28 

tributary switch 

LEDs 181 

troubleshooting 239 

U 

unframed mode 158 

upgrading the terminal 

uploading system files 224 

user ethernet capacity 148 

users 

access rights 63 

adding 63 

changing passwords 65 

deleting 64 

disabling 64 

saving user information 64 

session details 65 

user groups 63 

view user group 63 

V 

V.24 

serial data 126, 127, 128 

V.35 synchronous data 131 

W 

web browser cache, clearing 222 

WEEE 315 

X 

X.21 synchronous data 131 

 


